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Chapter One: Introduction 

Among the policy functions of state government, none is more important than the budget 
process. The budget is a plan of operation describing how the state will use its financial 
resources to meet the needs of the public. The plan includes an estimate of proposed 
expenditures and the means of financing the disbursements. 

The state’s budget, as recommended by the Governor and approved by the Legislature, originates 
with the individual budget requests of state agencies. Agency budget requests provide the 
information needed to prioritize programs and allocate financial resources accordingly. 

The budget is organized by program within each agency. The effectiveness of programs and 
efficiency of operations should be a consideration during the preparation of the agency budget 
request. 

Budget Base 

The general fund budget request for the 2021-23 biennium is limited to: 95 percent for ongoing 
base budgets less than $5 million; 90 percent for ongoing base budgets between $5 million - $20 
million; and 85 percent for ongoing base budgets greater than $20 million of an agency’s present 
general fund appropriation. Special funds will also be required to reprioritize 5 percent of the 
special fund appropriation. Adjustments will be made for one-time expenditures, such as capital 
improvements and phased-in programs. Each agency will be notified regarding its base budget 
limit. 
 
General fund budget needs beyond the 95/90/85 percent amount can be prioritized and requested 
in an Optional Request. All requests for new FTE, regardless of funding source, must be 
prioritized and requested in an Optional Request. There are no limitations to requesting federal 
funds unless it is for a new FTE or the agency is notified otherwise. However, agencies are 
encouraged to analyze all programs regardless of funding source to find simpler or more cost-
effective ways to operate.  
 
Any requests for special funds beyond the base budget need to be entered using an optional 
change package. There are no limitations to requesting federal funds unless it is for a new FTE or 
an agency is notified otherwise. However, agencies are encouraged to analyze all programs 
regardless of funding source to find simpler, more cost-effective ways to operate. 
 
Fiscal Environment 

All programs and expenditures will need to be analyzed and prioritized to ensure the budget 
remains structurally balanced. The 2021-23 budget process will require a greater emphasis on 
finding efficiencies, rethinking processes and collaboration between agencies.  
 
Agencies should not substitute federal funds or special funds for general fund moneys without 
considering the long-term availability of these funds. Agencies should also consider eliminating 
grants that are not core to the agency or state functions, consolidating or eliminating programs 
and services, and scrutinizing all FTE, along with travel, dues and professional development 
expenses. 
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Using the IBARS Manual 

This first chapter contains general introductory information including the fiscal environment, the 
budget base, using the IBARS Manual, and starting the budget process.  

Chapter 2 describes various general procedures for submitting an agency budget using IBARS.  

All IBARS windows are discussed individually in Chapters 3 through 9 of the IBARS Manual. 
Chapter 4 contains instructions for completing all windows used in budgeting salaries, wages, 
and fringe benefits. The remaining chapters contain instructions for all other windows. 

For each IBARS window, the window name is presented first. Next the “Navigation Path” is 
indicated for each window. This tells the user which menu options to select to access the 
window. The general purpose of the window is presented under the heading “Purpose.” Finally, 
the section titled “Using the Window” contains instructions regarding information to be included 
on a window. This section may also tell the user where to budget certain anticipated 
expenditures.  

Reports of various budget data can be viewed or printed through IBARS. Each available report is 
described in Chapter 10.  

Chapter 11 provides the glossary. 

The IBARS Manual includes links to various resources such as the Revenue and Expenditure 
Account Codes, Building and Infrastructure formulas, Legislatively Authorized FTE, and various 
agency billing rates to be used in building the 2019-21 budget request. Wherever possible, the 
IBARS Manual uses the same terminology as the PeopleSoft payroll and financial systems.  
 
Budget Process Timeline 

The statutory deadline for all budgets to be submitted is July 15, 2020, including the optional 
request. If an extension is needed, the request for an extension must be made in writing to the 
assigned budget analyst by July 1, 2020. Agencies are encouraged to submit the budget as early 
as possible to allow adequate time for analysis.  

Throughout the budget process, analysts will be available to answer questions on using IBARS 
or how to prepare the budget.  

After the budget is submitted, a budget review meeting may be held for each agency, if 
requested. The meeting will include a representative from the Office of the Governor, the Office 
of Management and Budget director, the budget analyst, and a Legislative Council 
representative. After the meeting, analysis of the request is completed and recommendations are 
prepared to reflect the executive budget policy. 

In August 2020 the first revenue forecast for the upcoming biennium is completed. In November 
2020, the forecast is updated to reflect current economic data and other factors. At that time, 
spending recommendations are finalized to correspond with anticipated revenue. 

The Governor presents the executive budget to the Legislative Assembly at the organizational 
session in December. Appropriation bills supporting the executive recommendation are then 
prepared and submitted. 
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The budget process and key dates are graphically displayed in the Budget Process Timeline on 
the following page. 
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Chapter Two: IBARS General Procedures 
This chapter includes an overview of IBARS and the specific steps to use in creating a budget 
request. Information is provided regarding: 

• Security and access  
• IBARS logon 
• Reporting levels 
• Copying, selecting and deleting budget versions  
• Subschedule copy function 
• Default funding  
• IBARS Help function 

Overview of IBARS 
The North Dakota Internet Budget Analysis and Reporting System (IBARS) was developed to 
meet the needs of state agencies, the budget office, and policymakers in North Dakota. IBARS 
provides a method for agencies to prepare a budget request. The system allows for the 
aggregation of the requested dollars at user-selected levels of detail and provides the ability to 
generate reports for management review at these various levels.  

In addition, IBARS facilitates the balancing of data entered on supporting schedule input screens 
with budget request figures. Amounts entered in the various subschedules are posted directly to 
the budget request when the subschedule is completed.  

IBARS is a web-based system and can be accessed on the OMB website https://www.nd.gov/omb/ 
under the “OMB Apps Login” drop down box in the upper right hand corner of the page.  

In addition to initial agency budget preparation, OMB uses IBARS to prepare the Governor’s 
recommendation.  

Security and Access 
User Types 
User type codes are assigned to each user when the user ID is created. Security settings and 
access privileges are established according to the user type code. Access privileges include 
“read/write” or “read only” access to screens, reports, narratives, the budget request checklist, 
and publications. Access can be allowed at the agency level or limited to specific reporting 
levels. The main user type codes are explained as follows: 
 
EA  Single department user – This user has access to all reporting levels within a single 

agency. 
DA Multi-department user – This user has access to multiple agencies. 
FA  Restricted Department ID user – This user has access to data within selected reporting 

levels for a particular agency. This security is set by EA or DA users through the security 
window on the reporting level maintenance screen. 

HA  Single department IT user – Large IT projects, IT equipment and software 
subschedules. 

https://www.nd.gov/omb/
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Access By Other Users 
Agency users can change OMB and Legislative Council access privileges for a specific budget 
version. Access by Legislative Council analysts and OMB may be set to open, closed, or read-
only for each version. To change access to a selected version, go to the Home tab and change the 
access indicator in the version status dropdown menu. If set to “closed,” the corresponding 
version is not included in the other user’s list of versions available for selection in the Versions 
tab. The “Read-only” access allows the respective user to view, but not change, data in that 
version.  

IBARS Login and the Main Menu 

IBARS Login 
Access to IBARS is obtained by accessing the IBARS under “OMB Apps Login” drop down 
menu in the upper right side of the OMB website https://www.nd.gov/omb/.  

 
Once the Login window is opened, enter a user ID and current password, both of which are case 
sensitive. For users with an Active Directory account, the IBARS user ID is the same as the 
Active Directory user name. If a new user ID is required, contact Lori Sondag at 328-4904. First 
time users are assigned a temporary password that should be changed once logged in to IBARS.  
 
If a user experiences three unsuccessful attempts to login to IBARS, the user’s access will 
be locked. In this event, the ITD Help Desk (701. 328.4470) must be contacted to reset the 
password.  
 
IBARS Home Tab Window 
The tabs at the top of the screen list all the initial selections for the navigation paths needed to 
access screens. The tabs include Home, Checklist, Versions, Publications, Logout, Menu, 
Reporting Level, and View. The Home tab window includes a message box to communicate 
pertinent information to IBARS users. Located between these two rows of tabs, known as Status 
Tabs, are the Action Bar Icons. Action Bar Icons are used to Save screen changes, Add a row, 
Copy data, Delete data, Export to Excel, access Help resources and Search. 
 
Changing a User Password  
To change a password while logged in to IBARS, select the Menu tab, expand the 
Administration dropdown by clicking on the blue triangle, and select Change Password. 
 
Reporting Levels 
 

Using the Window 
Defining Reporting Levels 
One of the first steps in preparing the budget is defining the reporting level structure. 
Establishing the structure is the same concept used in the development of the Tree 
Manager Structure in PeopleSoft. The reporting level structure is important for both data 

https://www.nd.gov/omb/
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entry and reporting in IBARS. Initially, OMB will copy the IBARS Reporting and Budget 
Level Maintenance Table from the previous biennium into 2021-23. This structure must be 
reviewed by the agency and updated to include reporting level changes for the present 
biennium and the biennium for which the budget is being requested. The reporting level 
structure must also accommodate the download of all historical data from the previous 
biennium. Notify the assigned OMB budget analyst of any needed changes to the table. 
Use the SR01 report to review the reporting level structure. 
 

      Defining Data Entry Levels 
The IBARS Reporting Level Type code defines the various data entry levels available. The 
value of this field is set prior to entering data for the Budget Request. The valid values are: 

A Accounting Level Data Entry - 4 digit Department ID. 
B Summary/Roll-Up Level (the organizational level at which the Budget Office reviews 

and modifies the Budget Request). 
X Neither a summary or data entry level. The “X” can apply to a reporting level above 

or below the other two values. 
 

Locking Reporting Levels to Start the Budget Request 
Once the reporting levels are established by the agency and approved by the assigned 
OMB analyst, the levels are locked by OMB and data entry can begin. After reporting 
levels are locked, it is not advisable to unlock and make changes to the table. Once the data 
is entered, the deletion of a reporting level could corrupt the IBARS database and require 
the agency to re-start the budget process. 
 Tip Do not create a version or enter any data until  

reporting levels are locked. 
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Copying, Selecting, and Deleting Budget Versions 
 
  Versions Window 

 
Navigation 
Log On =>Versions Tab 
 
Purpose 
The Versions window controls the access, creation, submission, and deletion of budget 
versions.   
 
Using the Window 
Upon first accessing the Versions window, select the biennium and the department. The 
biennium is named for the first year of the biennium. For example the 2021-23 biennium is 
named 2021. The default for the biennium is set to the budget request biennium. The 
agency is selected by default for users with access to only one agency. Selecting the 
agency displays the version options available to the user.   

 
For each version, the Version Number, Version Title, Type, Main Users, and Date Created 
are presented. An agency user is only able to create an A-Agency Work-in-Progress, or B-
Budget Request version, but may be able to view other versions, depending upon access 
established by the system administrator. 
 
Budget Version Defined 
The term budget version is used to identify the various stages of the budget from request 
to appropriation. A budget version is identified by several components including the 
biennium, business unit, a one-character code used to identify version type, and a two-digit 
number used to distinguish the multiple scenarios within a version type (example: 2019 
A2200110 is for the 2019-21 biennium, agency version #22, agency 110).  
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The option to have multiple variations or scenarios is available within certain version 
types. The version type description, letter identifier, and number of variations for certain 
version types are as follows: 
 
 

Version Type Description 
 

Letter Identifier 
Number of Variations for 

Each Version Type 
Download D 10 
Agency work-in-progress A 25 
Budget request B 1 
OMB analyst work-in-progress W 10 
Governor’s recommendation R 3 
Compensation C 35 

 
Control of and Access to Budget Versions 
The ownership of the budget version dictates who has control over opening, closing or 
limiting access to the budget data. The type of budget version identifies the ownership of 
the budget data. Generally, the office creating the version owns the data. For example, an 
agency owns the Agency Request version of data while the Budget Office owns the 
Governor’s Recommendation version.   

 
Copying a Version 
The first step an agency takes in preparing its budget is to determine the level of detail, 
accounting (type A) or budget (type B), at which to prepare the budget. Download versions 
supply the historical data from PeopleSoft, such as previous biennium expenditures, 
annualized current biennium first-year expenditures, and current biennium pay plan.  
 
To create a new version, identify an existing version and click the Copy button at the left 
of the screen. A Copy Version window will appear. Select the version type, such as “A” 
for Agency Version. A descriptive name may be entered into the Version Title box to 
readily identify the created version. Select an available New Version number. Under Copy 
Options, select “roll up” to create a budget level version. Without the roll up option 
selected, the created version will be at the accounting level when copying from a version 
that is at the accounting level. Narrative, payroll position information, and subschedules 
can also be selected to be copied to the new version. Always select Recalculate Payroll 
and Recalculate Column Formulas.  
 
After clicking Copy in the Copy Version window, another window will appear to confirm 
that the data should be copied from one version to another. A dialogue box will appear 
when the copy has completed successfully or explaining any errors. 
 
A newly created version contains the same data as the version from which it was copied, 
although it may be summarized at a higher level. The user can edit the newly created 
version while leaving intact the version from which it was copied. 
 
Selecting a Version 
After selecting the biennium and department, click on the desired Version Number in the 
fourth column of the screen. The Checklist will appear if the version was successfully 
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selected. 
 

Deleting a Version 
In order to eliminate a version, click Delete in the second column of the version to be 
deleted. A warning message appears to ensure the user wishes to delete the highlighted 
version. IBARS will only allow agencies to delete versions created by that agency. The 
delete was successful if the version no longer appears on the Version List. 

 
Exiting a Version 
To discontinue working on a version and begin working on another version, click on the 
Version tab and select a new version. 

 
Subschedule Copy 

Subschedule Copy Window 

 
Navigation 
Log On =>Menu Tab=>Preparation=>Subschedule Copy 
 
Purpose 
The Subschedule Copy function is used for copying payroll data, narratives and subschedule 
information from one version to another. Most commonly, this feature is used to copy 
narratives from the previous biennium R02 version to a current biennium A version. This 
feature is also useful for a user whose agency does not have its payroll information 
downloaded from PeopleSoft. Instead of manually entering each payroll record into IBARS, 
a user can copy some or all of the payroll records from a previous biennium budget version 
to a current biennium budget version. This feature can allow the previous biennium records 
to be copied or single-year records in one version copied to create identical year 1 and year 2 
records for the upcoming biennium. It can also be used to copy payroll records from one 
working version to another, or to a new version.   
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Subschedule Copy can only be used to copy between versions of the same type. For example, 
a B-level version can be copied to another B-level version. Contact the assigned OMB 
budget analyst for help with this procedure. 

 
Default Funding 
 

This feature, accessed through the Def Alloc tab on various subschedules, is intended to 
allow users to set a default funding allocation for a selected subschedule.  This feature is not 
enabled for North Dakota.  Funding allocation changes for payroll and expenditure history 
can be made through the download file by editing data in Excel.  Consult with your assigned 
budget analyst for additional information. 

 
Help 
 

Navigation 
Log On => Help 

Purpose 
Use the IBARS Help system to get immediate information about IBARS features and 
options. Click the Help icon. Select IBARS Users Manual, click on the link “North Dakota 
Specific Budget Manual.” You will be redirected to the OMB website. The remainder of the 
links in the Wiki were prepared by the IBARS developers with general information about the 
overall IBARS program. 
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Chapter Three: Getting Started 
Chapter three helps an agency get started building the budget request by providing: 

• A system overview to explain, in general terms, how data is collected in IBARS. 
• An overview of the steps involved in building the budget request, including the order in 

which subschedules should be completed. 
• Specific instructions for completing: 

o The Fund Source Control screen 
o The Change Package Description screen 
o Base Budget adjustments 

 Operating adjustments 
 Capital Asset adjustments 

 
System Overview 
 
Certain subschedules are used to collect data for the major components of the budget (i.e., 
salaries and wages, operating expenses, capital projects, etc.). These subschedules “post” data to 
the Budget Request Summary subschedule. The term “post” refers to the process by which 
budget amounts entered in a subschedule are automatically transferred to the Budget Request 
Summary and become part of the budget request. 
 
Other subschedules are used to collect supplementary information about the agency and its 
budget. These subschedules are used as support and documentation and, consequently, do not 
“post” budget amounts to the Budget Request Summary.  
 
Subschedules that post budgetary information to the Budget Request Summary screen are: 

• Position Detail Data 
• Operating 
• Grants Summary 
• Capital Projects 
• Extraordinary Repairs 
• Equipment over $5000 
• IT Equipment and Software over $5000 
• Other Capital Payments 

 
Subschedules that collect supplementary and supporting budgetary information are: 

• Large IT Projects 
• General Fund Collections 
• Licensing, Regulation, and Inspection 
• Lease Purchase Agreement 
• Continuing Appropriations 
• Special Fund Balance 
• Narrative 
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Tip Do not create a version or enter any data until  
reporting levels are locked. 

Tip Do not use Create. Versions “Created” contain no 
 download, expenditure, or salary data. 

Overview of Steps Involved in Preparing a Budget Request 

The sequence followed when using IBARS is critical to the proper functioning of the system and 
the development of a budget request that is complete and free of errors. The correct sequence is 
listed below: 

1.  Access IBARS using the user name and password assigned by the system administrator. 
If a password is forgotten or needs to be reset, call the ITD Help Desk at 701.328.4470. 
 

2. Review agency reporting level structure, as outlined in communications received from 
the assigned OMB budget analyst. Compare the IBARS SR01 report to the PeopleSoft 
Reporting Level Tree. All PS Department IDs from the 2017-19, 2019-21 and edits for 
the upcoming 2021-23 biennia should be in IBARS. 
 

3. Discuss with the assigned OMB analyst any necessary changes to the reporting level 
structure.  After changes are made, the reporting levels will be locked by OMB. 

 

 
4. OMB will create a download (D) version. The download version will include previous 

biennium expenditures, annualized current biennium first year expenditures, current 
biennium budget (if entered in PeopleSoft), and payroll information. The data will be 
loaded from PeopleSoft financials and PeopleSoft payroll for those agencies utilizing the 
PeopleSoft system. For other agencies, payroll data will need to be copied from the 
previous biennium budget request or entered manually. Contact your budget analyst if 
you would prefer to upload this information using an Excel template. 
 

5. Create an agency (A) version by “Copying” the D version. The D version can be copied 
to either an accounting level type (designated with an A in the type column) or a budget 
level type (designated with a B in the type column). Select the roll-up copy option to 
create a budget level version.  

 
6. Review downloaded expenditure data for the previous biennium (2017-19 Biennium 

Expenditures column of the Budget Request Summary) and annualized first year data 
for the current biennium (2019-21 First Year Expenditures column of the Budget 
Request Summary), including funding sources by line item. Generating the SRO5 report 
at the agency level will facilitate this review. The 2017-19 biennium data must agree with 
the final 2017–2019 NDS4310AA report. 
 
Full-time equivalent (FTE) information for the budget request biennium is based on the 
Payroll subschedule. Previous biennium and current biennium authorized FTE 
information must be entered by reporting level on the Budget Request Summary in the 
Statistics Object type. Refer to the authorized FTE table in the Appendix to ensure that 
previous and current biennium agency totals are correct.  
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7. Review current biennium appropriation amounts, including funding source by line item 
(2019-21 Biennium Appropriation column of Budget Request Summary). If the 
download from PeopleSoft does not include budget information, these amounts must be 
entered manually or uploaded from an Excel template. Contact the assigned OMB Budget 
Analyst for a copy of this template. 
 
The current biennium budget amounts should reconcile to the adjusted appropriation 
column on the NDS4130AA report dated 3/31/2020. FTE counts should not include any 
positions approved by the Emergency Commission during the current biennium because 
those positions must be requested through a change package. 

 
Salary account codes, along with the related funding, entered into the 2019-21 Biennium 
Appropriation column will automatically post into the 2019-21 Biennium Payroll 
Approp column, which is used to calculate the payroll difference from 2019-21. IBARS 
cannot identify funding sources for account codes included in special lines, so the 
expenditure account codes will post to the 2019-21 Biennium Payroll Approp column, 
but no funding amounts will post. For this reason, if the current appropriation includes 
any salaries account codes in special lines, the 2019-21 Biennium Payroll Approp 
column will appear out of balance. In this case, funding for special line salary account 
codes must be manually entered in the 2019-21 Biennium Payroll Approp column. 
 

8. The 2019-21 legislative base column should match to your ongoing legislative base from 
your agency appropriation bill. This amount must agree with your appropriation bill 
minus any one-time appropriations. 
 

9. Determine if narrative and subschedule data can be copied from the previous biennium. 
Use the Subschedule Copy function to copy from the 2019R02 version. 
 

10. Create budget changes in any posting subschedule.  See the chart later in this chapter for 
types of changes. 
  

11. Review the Position Detail Data subschedule (salaries, benefits, funding sources) and 
enter proposed changes. (See Chapter 4 – Payroll.) Ensure all authorized FTE for the 
current biennium are included. Adjust salaries to the anticipated June 30, 2021 salary. 
Add new positions requested for 2021-23 in an optional change package, regardless of 
funding source. 
 

12. Check “complete” on Position Detail Data subschedule indicator on the Checklist to post 
the data to the Budget Request Summary. 

 
13. Review Payroll Difference from 2019-21 column in Budget Request Summary. These 

costs cannot be entered manually and may not be edited after being calculated by IBARS.  
 

14. Complete all posting and supplementary subschedules except Special Fund Balance.  
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Tip All budget request data must be entered in the posting 
subschedules, not directly in the budget request summary. 

 Click “Complete” on each subschedule to post 
data to the budget request summary. 

 
15. Check “complete” on the Budget Request Summary indicator on the Budget Request 

Checklist to post data to the Special Fund Balance subschedule. 
 
16. Complete the Special Fund Balance subschedule and mark it to complete on the checklist. 

 
17. Run the IBARS SR05 report to review the budget request to ensure that it is complete and 

that funding and expenditures balance. 
 

18. Run the SRO6 and CRVA reports to identify any outstanding validation issues that must 
be corrected prior to submitting the budget. 

 
19. When all subschedules have been marked to complete and validation issues corrected, 

click the Submit button located on the Version tab. 
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Complete
1 Reporting levels

a. Review agency reporting level structure
b. Compare IBARS SR01 and PeopleSoft Reporting Level Tree to ensure that all PS Dept ID's are included in IBARS

2 Create working version
a. Copy D version to A version

3 Review downloaded expenditures in A version
a. Print IBARS SR05 report at Agency level (SR05A)
b. Verify that 2017-19 Expenditures column on SR05A matches Expenditures column on 06/30/2019 PS 4310AA report
c. Verify that 2019-21 Appropriation column on SR05A matches Current Appropriation column on 03/31/2020 PS 4310AA report

i. If the download from PS does not include budget information, these amounts must be entered manually
d. Verify that 2019-21 legislative base column matches the agency ongoing appropriation from the appropriation bill.
e. Review 2019-21 First Year Expenditures column to ensure that annualized amounts calculated in IBARS are reasonable
f. Enter 2017-19 and 2019-21 biennium FTE information

i. Use Authorized FTE schedule included in IBARS Manual Appendix to verify that agency total is correct
g. Manually enter funding source data in 2019-21 Payroll Appropriation column for any salary objects included in special lines
h. Run IBARS SR05 report with Negative Values and adjust to eliminate any negative amounts.

4 Subschedule copy
a. Determine if narrative and subschedule data can be copied from previous biennium
b. Use Subschedule Copy function to copy from 2019R02 version

5 Change packages
a. Create budget changes in Change Package Description
b. Ensure only AE and AF change types are used in Remove Capital and One-Time column
c. Ensure only AA and AB change types are used in Budget Request column
d. Ensure only AC, AD, and AG change types are used in Optional Request column

6 Position Detail Data 
a. Review Position Detail Data
b. Enter any existing positions not included in A version
c. Review the Salary Amount on Pos Info tab for each position
d. Adjust amounts to reflect salary rate that will be in effect on 07/01/2020 for each position
e. Enter any new positions to be included in 2021-23 base or optional request
f. Print and review IBARS CR01 report
g. Check complete on Position Detail Data

7 Complete all Posting Subschedules (If not required for your agency, just mark to complete on checklist)
a. Operating
b. Grants Summary
c. Capital Projects
d. Extraordinary Repairs
e. Equipment Over $5,000
f. IT Equipment and Software Over $5,000
g. Other Capital Payments

8 Complete all Supplmentary Subschedules (If not required for your agency, just mark to complete on checklist)
a. Large IT Projects
b. General Fund Collections
c. Licensing, Regulation, and Inspection
d. Lease Purchase Agreements
e. Continuing Appropriations

2021-23 AGENCY BUDGET REQUEST PREPARATION CHECKLIST 
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9 Narrative Subschedule
a. Review copied narrative
b. Save copied data in each narrative field to remove font specifications
c. Enter new narrative data as required
d. Generate NARR report
e. Review narrative data
f. Check Narrative Subschedule to complete

10 Review Budget Request
a. Print and review IBARS SR05 report to ensure budget request is complete
b. Mark Budget Request Summary complete on checklist

11 Special Fund Balance Subschedule
a. Open Special Fund Balance Subschedule
b. Review Detail Tab information for each special fund
c. Enter appropriate revenue codes and revenue estimates for 2019-21 and 2021-23
d. Enter adjustment to 2019-21 appropriation to reflect estimated expenditures, if necessary
e. Mark Special Fund Balance Subschedule to complete

12 CRVA report
a. Run CRVA report to identify any outstanding validation issues
b. Correct issues
c. Check to complete any unchecked subschedules

13 Submission
a. Select Versions Tab
b. Click Submit link next to version number 
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 Fund Source Control 
 
Fund Source Control Window 

 

 
Navigation 
Log On =>Menu=>Administration=>Admin Tables=>Fund Source Control 
 
Purpose 
To define the special and federal funding sources available statewide and for each specific 
agency.   

 
Using the Window 
Select the correct agency number from the drop down in order to view funds available for the 
agency. Review the special fund list for completeness, keeping in mind the need to 
encompass a three-biennium period including the budget request biennium. Contact the 
assigned OMB analyst to modify the fund list.   
 
Click in the description field of a fund, and then click the Fund Balance Maintenance tab to 
view the beginning fund balance for the current biennium. Once in the Fund Balance 
Maintenance window, use the Fund dropdown menu to review the balance of each special 
fund. Contact the assigned OMB analyst to modify a beginning fund balance. 
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Change Package Description 
 
 Change Package Description Window 

Navigation 
Log On =>Checklist=>Any Posting Subschedule=> Change Package Description 
Purpose 
To define the change packages to be used in preparing the budget request.   
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Using the Window 
A change package is used to remove current biennium one-time and capital asset 
appropriations and to enter any difference between the current biennium appropriation and 
the amount to be included in the agency’s base budget request for each account code and 
funding source. Amounts included in the optional budget request will also be entered as a 
change package. Any budget change entered will be available for use in all reporting levels 
and subschedules.  
 

Change Package Group and Type 
 

All agency changes regardless of type are Group A.  Budget changes are organized into 
seven categories, or types: 
 

Type A = Base budget changes to be included in the base request. 
Type B = Base budget one-time request. 
Type C = Optional change included in the optional request. 
Type D = Optional one-time change to be included in the optional request. 
Type E = Remove prior biennium one-time items. 
Type F = Remove capital asset appropriations. 
Type G = Optional savings 
 

Within the subschedules, dollar amounts must be entered into the appropriate columns based 
on the type of change, as shown in the following table. 
 

Change Packages Remove Capital 
& One Time 

Budget 
Changes 
Column 

Optional 
Request 
Column 

Remove prior biennium one-time AE   
Remove capital AF   
Base budget change  AA  
Base budget one-time  AB  
Optional change   AC 
Optional budget one-time 
Optional savings   AD 

AG 
USED ONLY BY OMB    

OMB Recommendations  RA  
One-time OMB Recommendations  RB  
 

After the budget change is created and saved, all fields can be modified except the group, and 
type.  
 

Make sure the priority number reflects the agency’s actual priority listing for this change 
package. The priority field should be completed for all optional change packages and 
left blank for other change package types.  Create as many change packages as necessary 
to adequately identify agency priorities. 
 



Chapter Three: Getting Started          April 13, 2020 

3 - 10 

Tip  Do not use the same change package to enter amounts  
in both the base and optional request. 

Tip  Do not include symbols or special characters such as &, 
or hyphens, in budget change titles and descriptions. Tip  Do not repeat the same information in the short description 

and the narrative. Budget Change Narrative reports 
print the title, short description and narrative  

for each budget change. 

Change Package Title, Description, and Narrative  
The change package description window includes a title field to accommodate a title for each 
change package. The window also includes a second short description field. The short 
description field is not required. If used, please include only a short summary statement. The 
title and the narrative field are required fields that must be completed for each change 
package.  One-Time indicator and Print boxes are not used. 
 
After completing and saving the Change Package Description window, open the Narrative 
tab. For each change package in the Change Package Description window enter a detailed 
description and justification for each change package.  
 
If your request includes a large IT project, use the same change package for entries in all 
subschedules associated with the project. Use the description “IT – [name of IT project]”. 
See Chapter 7, Large IT Projects. 
 

 
Deleting Budget Change Packages 
If a change package must be deleted, all associated dollars must first be zeroed out of the 
change package in each reporting level. Click Complete on the Budget Request Checklist 
prior to deleting any associated lines that were inserted. This must be done through the 
subschedule used to enter the data. If a change package is deleted without first removing the 
dollars and checking Complete, the associated amounts will not be deleted from the database 
and the budget will not pass validation. 
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Chapter Four: Position Detail Instructions 
 
Initial salary and benefit information is based on a download from the PeopleSoft payroll system.  
Consequently, it will include only positions filled as of the download date, and those not 
included will need to be added manually. 

A summary of the windows and tabs used to view and prepare the total salaries budget request is 
presented below. 

Checklist Window 
Position Detail Data – By checking Complete, the system will recalculate and allocate the 
total salary and benefits for the agency. The salary and benefits amounts will be posted to 
each reporting level in the budget request.   

  
Position Information 

Position List tab – Provides a list of each employee. Each employee is listed twice, once 
for each fiscal year of the biennium. This window is used to add new FTE or access and 
edit position information. Data displayed include:  year, employee ID, position type, 
position number, position name, class code, title, and salary amount. 
 
Position Info tab – Used to view, update, and enter specific data for an individual 
employee position such as classification code, salary level, pay type, position type, and 
change package if applicable. This window is also used to unfund an existing position. 
 
Position Benefits tab – Used to view, update and enter fringe benefit information for 
specific individuals. 
 
Position Benefit Calculations tab – Used to view the resulting salary and benefits 
amounts based on the information entered in the Position Info and Position Benefits tabs. 
 
Position Calculations tab – Displays monthly salary and benefit data for a specific 
individual. 
 
Position Allocation tab – Used to specify the reporting levels and funding sources for 
each position. 

Position Employee tab – Displays the employee ID number, name and anniversary date 
for existing employees. Also used to enter a new employee. 
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Position Data 

Position Data Screen 

 
Navigation 
Log on=>Menu=>Preparation=>Position Data Maintenance=>Position 
Information=>Position List tab  
or   
Checklist=>Position Detail Data=>Position List tab 
 
Purpose 
Add, delete and change employee name, position number, identification number, and 
position type. This screen is also used to add new FTE that are being requested. Vacant, 
shift differential, overtime, temp and board member positions are not included in the initial 
payroll download and need to be added to the position list. A line of data must be 
completed for each year of the biennium. 

 
 General Information 
 Before updating the Position List, note the following:  

• Emergency Commission and Budget Section approved positions continuing into the 
next biennium must be requested as new positions and requested through an Optional 
Budget Change Package. 

• New employees, additional temporary, overtime or shift differential dollars, and other 
salary changes that will increase the budget request must be documented and 
requested through a Budget Change Package, regardless of the funding sources used. 

• The positions on the Position List window may be sorted according to the user’s 
preference by clicking on the corresponding column heading. 

• The system rounds if more than two decimal places are used. 
• Temporary, overtime, board member, shift differential, pooled and equity adjustment 

are not included in the position data download. These position types must be added. A 
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separate position should be set up for each reporting level in which temporary, 
overtime, shift differential, equity adjustment, and pooled positions are used. Multiple 
temporary, overtime, pooled, or shift differential positions may be labeled in the Emp 
ID field as Temp1, Temp2, Overtime1, Overtime2, etc. 

• For shared positions, the total FTE must not exceed 100 percent. 
• If an employee is being paid from more than one reporting level, the total must not 

exceed 100 percent. The percent can only be entered up to two decimal places.  
• The only agencies that may use “Pooled” positions are components of the North 

Dakota University System. 
• If funding allocation for salary increases is different than regular salary, the regular 

salary allocations and the salary increase allocations must each equal 100 percent. 

Using the Window 
On the Reporting Levels tab, expand the reporting levels and select the appropriate 
reporting level. To view a list of all agency positions, select the top reporting level. 
 
Click the Add icon on the action bar to add a new record, or click on the Pos No for an 
existing record to make changes to the present data.   
 

 Add an Existing or new Vacant Position  
From the Position List window, select the reporting level, and click the Add icon. Select 
Add Position from the dialogue box. Enter all required information on the Position Info 
screen. If entering a vacant position, enter “0” in the Emp ID field and the word 
“Vacant” will automatically populate the Pos Name field. Click the Save icon when the 
record is complete. Click the Pos Benefits tab and select benefit types for this position. 
Click the save icon. Click on the Pos Alloc tab to change the fund and allocation percent 
for the position.Return to the Pos Info tab. In the Replicate Position box at the bottom of 
the window, put a “1” in # of Positions to Replicate; choose Selected Year to Other 
Year in Copy Options. Leave New FTE Indicator set to copy. Vacant and Annotate 
Position Name should be blank. Click the Replicate button to copy this position to the 
second year of the biennium. 
  
Add a Record for a New FTE 
From the Position List window, select the reporting level, and click the Add icon. Select 
Add Employee from the open dialogue box. Enter the Emp ID and Name. Click the 
save icon. Return to the Pos List tab and click the Add icon. Populate all fields, using 
“1” in Step, and “0” in Emp ID, which should then display “Vacant” in the Name field. 
The Compute Increase Indicator must be checked if this position is eligible for general 
salary increases. The New FTE Indicator must be checked for all new positions. Update 
the record by clicking the Save icon. Navigate to the Position Benefits and Position 
Allocation tabs, populating all required fields and saving when complete. Return to the 
Position Info tab and use the Replicate Position box to copy this position to the second 
year of the biennium.  
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Tip If one position is split between two or more reporting levels, 
enter one position number and allocate that position, 

using the Position Allocation tab, to the appropriate reporting levels. 
 

Replicate Position  
The Replicate Position function can be used for adding multiple positions by changing 
the # of Positions to Replicate and the Copy Options to copy to one or more years of 
the biennium. When copying to multiple positions, select the “Annotate Position Name” 
indicator to auto-generate a unique name for each new position. Return to the Position 
Listing tab and select a newly replicated position. Change the Position Number to a 
unique sequence, the Emp ID to “0” if a vacant position, and clear out the Revised 
Position Name field. Save the updated record. 
 
Add a Board Member 

 Board Members can be added one of three ways: 
1. Click the Add icon and input a specific position number for each member and 

insert the Board Member’s Employee ID and Name. 
2. Click the Add icon and input Board Member 1, Board Member 2, etc. in the 

Position No, Employee ID, and Name fields. 
3. Use one entry for the biennium or one entry per year, for all board member 

compensation. To accomplish this, enter the words “board member” in the Emp 
ID field, and enter a total amount for the salaries of all members.    

 
 
 
 

 
 
Temporary Employees, Shift Differential, Overtime and Equity pools 
If an agency has multiple temporary employees, shift differential, overtime and equity 
pools, each should be identified in the Position Number and Employee Identification 
fields with a sequentially numbered title such as Temp 1, Temp 2, and Overtime 1 and 
Overtime 2. Zero (0) should not be used in the employee identification number field 
for these Position Types, only vacant Regular FTE positions. 
   

Temporary Budget for temporary positions using the Position Type 
Code “T - Temporary.” Type “Temp” in the Pos No and 
Emp ID fields. Do not check the compute increase 
indicator checkbox. On the Position Benefits tab select the 
standard fringe rate, leaving other benefit types blank. 
Select class code NC9008 or NC9031 to NC9038. Enter 
one FTE. The FTE field is required for the compensation 
amount to calculate correctly, however, the FTE will not be 
added to the agency’s FTE total. 

 
Board Member  Budget for board member compensation using the Position 

Type Code “B – Board members.” Budget for board 
member compensation using a lump sum for all board 
members, or enter individual board members. Do not check 
the compute increase indicator checkbox. On the Position 
Benefits tab select the standard fringe rate, leaving other 
benefit types blank. Select Class Code NC9006. Enter one 
FTE. The FTE field is required for the compensation 
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Tip  Salary Equity adjustments will not be displayed on the 
CR02 reports because that report does not 

include lump sum amounts. 
 

 

amount to calculate correctly; however, the FTE will not be 
added to the agency’s FTE total. 

 
Resident Worker Budget for residents who are paid for hours worked using 

the Position Type Code “W – Resident Workers”. This 
position code is applicable only for the Veterans’ Home 
and the State Hospital. Do not check the compute increase 
indicator checkbox. On the Position Benefits tab select the 
standard fringe rate, leaving other benefit types blank. 
Select class code NC9008 or NC9031 to NC9038. Enter 
one FTE. The FTE field is required for the compensation 
amount to calculate correctly, however, the FTE will not be 
added to the agency’s FTE total. 

  
Equity Adjustment Use position type “E – Equity Adjustment” on the Position 

Information tab for salary equity increases. Do not check 
the compute increase indicator checkbox. On the Position 
Benefits tab, leave all benefit fields blank. Select Class 
Code “NC9998.” Enter “1” in the FTE field, “annual” in 
the Pay Type field, and “0” in the Rate field. Enter the total 
biennial cost of the equity adjustment, along with any 
associated fringe benefit costs, in the Lump Sum Amount 
field. Enter “Equity,” or a similar short description, in the 
Lump Sum Description field. Leave Position Benefit fields 
blank.  

 
 

 

Underfund Salary Use position type “U - Underfund Salary” to reduce the 
salary budget by a lump sum amount as discussed with the 
assigned budget analyst. Do not check the compute 
increase indicator checkbox. On the Position Benefits tab, 
leave benefit fields blank. Select Class Code “NC9998.” 
Enter “1” in the FTE field, “annual” in the Pay Type field, 
and “0” in the Rate field. Enter the total biennial cost of the 
underfunding, along with any associated fringe benefit 
costs, as a negative number in the Lump Sum Amount 
field. Enter “Underfund Salary,” or a similar short 
description, in the Lump Sum Description field. 

 
Executive Budget The position type “X – Executive Budget Adjustment” is 
Adjustment  for OMB use only. 
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Position Information 
 
Position Information Tab 

 
Navigation 
Log on=>Checklist=>Position Detail Data=>Pos No for desired position=>Position 
Information Tab 
 
Purpose 
The Position Info tab is used to enter individual position data, such as class code, position 
number, position type, and payroll rates. The initial data in IBARS is based on the month 
of the download from the PeopleSoft payroll system. 
 
Using the Window 
Select a Pos No on the Position List window to navigate to the Position Info tab for that 
record. The salary information is displayed in each field for that particular position. If a 
new record is being added, from the Pos List tab, click the Add icon, then select Add 
Position to open a blank Pos Info window.   

 
This window contains the Position Classification code, Position Number, Employee ID, 
FTE, Position Type Code, Pay Type Code, Unfunded Indicator, Rate of Pay, and 
Duration. Review the information for accuracy. Make changes by clicking on the specific 
field, enter the correct value, and then tab to the next field.   
 

Year In order for a position to be fully funded, there must be one 
position for each year of the budget biennium: 2021 and 
2022. 

 
Position Number Unique indicator based upon PeopleSoft payroll records or 

agency numbering system. 

file://ITDDATA12/OMB-PUBLIC/WEBSITE/FISCAL%20WEBSITE/BARS2008/Appendix/job-classification-index.pdf
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Step  Field is not used by North Dakota and has been disabled. 
 
Position  Populated automatically by IBARS if a position number is 
Sequence No.  used more than once for a given year. 

 
FTE  Portion of a full-time position held by the employee. 
 
Employee ID This is the PeopleSoft Employee ID number. Enter “0” for 

vacant positions, which will automatically insert “Vacant” 
in the Name field. Use “Temp” for temporary positions. 

 
Employee Name Downloaded positions are prepopulated. For vacant or new 

positions it automatically populates based upon the 
employee ID. 

 
Unused Fields  Some fields are not used by ND and have been disabled. 

The fields labeled Anniversary, Longevity, Date 2, and 
Date 3 are not applicable to North Dakota and will not be 
used by agencies in preparation of their budget. 

 
Position Type Code B – Board Members –Board members are not included in 

the payroll download and must be added to the Position 
List.  
E – Equity Adjustment – Code is used by agencies to add a 
pool of funds for salary equity. 
F – Faculty and L – Pooled are only used by components of 
the North Dakota University System.  
O – Overtime 
R – Regular Employee – The code for permanent 
employees used by North Dakota.   
S – Shift Differential – Code is used by agencies for shift 
work compensation, such as the Mill and Elevator. 
T – Temporary –Temporary positions are not included in 
the download information from the PeopleSoft payroll and 
must be added to the Position List. 
U – Underfunded Salary – Code is used by agencies to 
underfund the salary plan in anticipation of savings related 
to vacancies and turnover. 
W – Resident Worker used only by State Hospital and 
Veterans’ Home, etc.  Resident workers will have to be 
added and are not included in the payroll download. 
X – Executive Budget Adjustment – To be used by OMB 
only. 

 
Pay Type Code Can choose Annual, Bi-Weekly, Daily, Hourly or Monthly, 

as appropriate for each employee. 
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Tip   Budget changes should be entered for both years 
of the biennium for each position. 

 
 

Duration   Prepopulates based on Pay Type code used. Contact the 
assigned budget analyst before changing to fit a unique 
situation. 

 
Unfunded Indicator Select “Funded” for funded positions and “Unfunded-Do 

Not Post” for unfunded positions. The “Unfunded-Do Not 
Post” option allows existing positions to be excluded from 
the budget request without deleting the position record. Do 
not mark a position as unfunded if the position is part of an 
optional request. Do not use “Unfunded – Post” (this 
option is not used by North Dakota). 

 
Rate Wage paid to an employee that corresponds with Pay Type 

code used. The rate must reflect the full FTE rate for partial 
FTE positions. For example, a .5 FTE making $1,000 per 
month is entered as .5 in the FTE field and $2,000 in the 
rate field, and monthly in the pay type field. 

 
Compute Incr Ind The compute increase indicator is automatically checked 

for each employee position. A check mark in this box 
means that the position is set to receive any statewide 
compensation increase that is recommended. Uncheck the 
box if a position should be excluded from the increase, 
such as in the case of board members and temporary 
positions. 

 
New FTE Place a check mark in this field if the position is a new 

position for the agency. 
 
Salary Amount This is a calculated field utilizing the entered rate and 

duration. 
 
Budget Change The Budget Change field must be used for all new 

positions. Select the appropriate Budget Change Package 
from the dropdown list. 

 

Lump Sum Amount Can be used to budget for items such as retirement payout, 
equity requests, etc. Enter the dollar amount of the request. 

 
Lump Sum Descr Enter a short description for lump sum amounts requested. 
 
Revised Position Only used when replicating positions. See instructions later 
Name  in this chapter. 
 

Once an employee record is complete, click the Save icon in the Action Bar to save the 
data. 
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Replicate Position 

 
# of Pos to Replicate The number of positions to be generated during replication. 

 
Copy Options Select the years to which the existing position should be 

copied for the new positions.  
 
New FTE Indicator If selected, copies the New FTE Indicator to the new 

record. 
 
Vacant If selected, the replicated record will have a “0” in the Emp 

ID field and Name will be “Vacant” 
 
Annotate  If selected, changes the Name field to “Copy of xxxx” for 
Position Name  the replicated record. 
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Position Benefits 
 

Position Benefits Tab 

 
 
Navigation  
Log On=>Checklist=>Position Detail Data=>Pos No for desired position=>Pos Benefits Tab 
  
Purpose 
The Position Benefits tab is used to enter individual position data, such as health insurance, 
FICA, unemployment, and workers compensation codes. The initial data in IBARS in based 
on the month of the download from the PeopleSoft payroll system. 
 
Using the Window 
Select with the cursor an employee record on the Position List window. Click on the Position 
Benefits tab. The downloaded benefit information is displayed in each field for that particular 
position. If a new record is being added, the fields will be blank. 
 
The window includes the fringe benefit fields of Health Insurance, FICA, Retirement, 
Unemployment, Workers Compensation, Medicare, Life Insurance and Employee 
Assistance. The Standard Fringe field is used only for positions that do not receive the full 
state benefit package. 
 
Refer to the Appendix for the list of Fringe Benefit Codes. 
  
Review each position to make certain the benefit information is accurate and current. To 
make changes, click on the selection in the drop down next to each field. Tab to the next 
field. Click the Save icon when all fields are completed. 
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Tip The Standard Fringe field is used for Temporary Employees, 
Resident Worker, Board Member and Pooled positions only. 

If this field is used, the other fringe benefit fields should remain blank. 

 
Benefit Calculation 
 

Position Benefit Calculation Tab 

 
Navigation  
Log On=>Checklist=>Position Detail Data=>Pos No for desired position=>Pos Ben Calcs 
Tab 
 
Purpose 
This is a view only window that provides an itemized list, per employee position, of salary 
and fringe benefits calculations. Users cannot make entries on this screen. 
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Position Calculation 
 

Position Calculation Tab 
 

 
Navigation  
Log On=>Checklist=>Position Detail Data=>Pos No for desired position=>Pos Calcs Tab 
 
Purpose 
This is a view only window that provides a monthly itemization, per employee position, of 
salary and fringe benefits calculations for each month. Users cannot make entries on this 
screen. 
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Tip  The Position No., Position Sequence Number, Year, Employee Name and 
Reporting Level are displayed at the top of the window to assist users. 

Review this information to ensure that the correct 
 position is open before entering allocation data. 

 
Tip For existing positions, the information displayed in each of the 

fields is based on the allocation used in the PeopleSoft payroll 
download. If the data is the same as the allocation method for 

the next biennium, no entries are required on the screen. 

 

Position Allocation 
 
Position Allocation Tab 

 
Navigation    
Log On=>Checklist=>Position Detail Data=>Pos No for desired position=>Pos Alloc Tab 

 
Purpose 
To allocate the salary of the selected position to reporting levels and specific funding 
sources. 
 
Using the Window 
Go to the Reporting Level field and select from the drop down list, the reporting level that 
will be used to begin the allocation of salary. 

 
If allocation changes are required, the Reporting Level, Fund, and Payroll Line dropdown 
fields display available allocation options. The drop down box will provide the choices of 
General Fund 001, specific Special Funds used by an agency, and Federal Funds listed by 
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Tip If a position needs to be moved from one reporting level to 
another, simply change the reporting level for that individual 

on the Position Allocation tab rather than deleting and creating a new 
position on the Position List tab. Remember to update 

the allocation for each year of the biennium. 

 

individual grant numbers. If a fund is missing from the selection, contact the assigned 
budget analyst. 
 
Make a selection from the choices, tab to the Allocation Percent field. Enter the decimal 
value less than or equal to 1.00 for the portion of salary that will be charged to the fund 
identified in the Fund field.  
 
Enter rows using the Add icon as required.  

 
The Increase Indicator field should remain blank in most cases. When the funding 
allocation for the executive salary increase is different than for the base salary, insert a 
new line. Place a checkmark in the field indicating that these allocations should be used 
for salary increases only.   

 
Click the Save icon to save the data. 
 
Repeat this process for the second year of the biennium by returning to the Pos List 
screen and selecting the second year position. 
 
 

  
 

 

Funding Reallocation  

 Default Allocation Window 
 

Navigation    
Checklist=>Position Detail Data=>Default Allocation Tab 

 
Purpose 
To perform funding reallocation of positions within a selected reporting level. 

 
 This function is not currently available for use in North Dakota.  

 

Salary Increase  

Salary Increase Window 
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Navigation    
Log on=>Menu=>Position Data Maintenance=>Salary Increase  
 
Purpose 
This screen can be used to run various salary increase scenarios for an entire agency and 
apply increases to all or select groups of agency positions. 
 
Using the Window 
Verify that the Version Number is correct. 
 
Skip the drop down field. 
 
Tab to the next field and name the salary scenario. Click save. A new row will appear, 
allowing you to select start date and end dates from the 24 months of the biennium.  In 
most cases, select month 1 as the start date and month 12 as the end date.  Use the 
subsequent fields to enter a minimum amount per pay period and/or a percent increase. 
 
Use the Add icon to enter a new row for the second year of the biennium.  Select month 
13 as the start date and month 24 as the end date. Enter salary increase minimums and 
percentages for the second year.  Select the Incl Prev Incr checkbox to ensure that the 
second year increase includes the compounding of the first year increase.   
 
Select the Delete Previous Salary Increase to ensure that data relating to any previous 
salary increase is deleted. Select the FTE Prorate Increase checkbox to provide that any 
minimum salary increase amount is prorated based on the FTE. 
 
In most cases, select Increase Allocation to keep base salary amounts unchanged and 
calculate a separate increase.  If Salary Allocation is selected, the salary increase will 
permanently change the base amount. 
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Tip Do not select Salary Allocation unless you intend to permanently change 
the base salary amounts in the pay plan for all positions. 

 

 
 
 
 
 
 
 
Save selections.  Click Run Salary Increase button to calculate salary increase.  
 
To remove calculated amounts, change Amt Per Pay Prd and Pct Per Pay Prd to 0, save, 
and rerun salary increase.  
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Tip  Other than adjusting FTE counts, 2017-19 actual expenditures and the  
2019-21 appropriation and estimated expenditures, no other 

data is entered directly into the Budget Request Summary window. 

 

Tip  Actual expenditures for the 2017-19 biennium should reconcile 
to the 6/30/2019 NDS4911-BB report dated 7/31/2019. 

Chapter Five: Budget Request Summary 
 
Chapter five serves as a guide through the process of using the Budget Request Summary 
window. The Budget Request Summary window is used to: 

• Summarize all budget data entered in various subschedules. 
• Enter prior and current biennium expenditure and funding data for all lines. 
 

Budget Request Summary 
 

Budget Request Summary Window 
 

Navigation 
Log On =>Checklist =>Budget Request Summary 
 
Purpose 
The Budget Request Summary window provides the historical data, budget changes 
information, and budget request for each reporting level and summarized for the entire 
agency. 

General Information 
Several windows are involved in preparing the budget request summary. Amounts entered 
in “posting” subschedules (operating expenses, grants, capital projects, extraordinary 
repairs, other capital payments, position detail data, equipment over $5,000, and IT 
equipment and software over $5,000) post to the budget request summary when each 
subschedule is checked to complete on the Budget Request Checklist.   

  
 

 

 
Prior biennium expenditures, first year expenditures, and current biennium appropriation 
columns are downloaded from PeopleSoft. If the download month is prior to the close of 
the first year of the biennium, salaries and operating expenditures are annualized. Other 
account codes use actual expenses as of the download month. If the current biennium 
budget was not spread in PeopleSoft, the download will not contain this information. 
Consequently, in such a case, the current biennium appropriation amounts by account code 
and funding source will need to be entered manually. 

Using the Window 
The Budget Request Summary consists of multiple columns, each with unique functions, as 
described below: 

2017-19 Biennium Expenditures shows complete prior biennium expenditures, by account 
code, line item, and funding source. These amounts should be part of the download version 
used to create the first working version in IBARS. However, these amounts should be 
checked and modified as necessary to accurately reflect historical expenditures. 
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 To enter data in the budget request summary, select the 

appropriate reporting level. Click the “Detail” tab to enter 
account code or funding source detail in the available columns.  

Select Funding or Expenditures from the Object Type drop 
down. Select the appropriate Line Item from the drop down list. 
Click on the appropriate cell to edit existing data, or click the 
“Add” icon to enter a new account code or funding source. 

 

Important 
Note 

 

 

2019-21 First Year Expenditures shows annualized expenditures for the first year of the 
current biennium. These amounts should be part of the download version used to create the 
first working version in IBARS. However, due to the actual timing of certain expenditures 
and the timing of the download version, annualized expenditures may not accurately 
represent anticipated fiscal year expenditures for a particular account code, line item, or 
funding source. Adjust these amounts as necessary. 

2019-21 Biennium Balance shows the remaining unexpended balance by account code for 
the current biennium. This is a calculated column based on the annualized amounts in 
2019-21 Fiscal Year Expenditures and the amounts entered in 2019-21 Biennium 
Appropriation, as explained below. 

2019-21 Biennium Appropriation reflects the appropriated budget for the current biennium. 
Amounts in this column should be part of the download version used to create the first 
working version in IBARS. However, if the agency’s budget has not been spread in 
PeopleSoft, this column will be empty in the download version. In that case, these amounts 
will need to be entered manually by account code and funding source in working versions. 
These numbers will be closely scrutinized throughout the budget process and serve as the 
base for any budget changes requested for the upcoming biennium. For this reason, care 
should be taken in entering these numbers. Make sure that in total, the amounts entered 
in this column tie to the Current Appropriation column of the NDS4310AA 
PeopleSoft Appropriation Status Report, For the Month Ending 3/31/2020 for each 
line item and major funding source category. Please contact the assigned analyst prior to 
using an Appropriation Status Report with a different date. 
 
Adjustments to Legislative Base is a calculated column that compares the 2019-21 
legislative base to the 2019-21 biennium appropriation column (explained above). 
 
2019-21 Legislative Base reflects the legislative approved budget for the current biennium. 
Amounts in this column should match your ongoing base from your agency appropriation 
bill. This amount must agree with your appropriation bill minus any one-time 
appropriations. These amounts can be uploaded in the Excel file used to upload agency first 
year expenditures and current biennium appropriation. If your agency does not use the 
upload, these amounts can be manually entered in the Budget Request Summary screen. 
Make sure that in total, the amounts entered in the column tie to the agency appropriation 
bill for each line item and major funding source category. 
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Current Biennium Payroll Appropriation is used to show the current biennium 
appropriation for payroll. Most amounts will be filled in automatically by IBARS when 
other columns are updated. However, if any salary objects are budgeted under special lines, 
the expenditures and funding in this column may not balance. This is due to the fact that 
the funding sources for salaries objects that are part of a special line are not specifically 
identified and must be manually entered. 
 
Current Biennium Payroll from Subschedule will be populated upon checking Complete on 
the position detail data subschedule. This column represents the biennial cost of payroll for 
all existing positions included in the budget request. It does not include the cost of any new 
positions or existing positions assigned to an optional change package. 

Payroll Difference from Current Biennium will be calculated by IBARS based on amounts 
contained in other columns. This column shows the increase over the current biennium 
appropriation needed to sustain the salary level in effect as of the end of the current 
biennium. Consequently, the cost of any salary increases given during the biennium, any 
new positions that were phased in during the current biennium, as well as other costs 
incurred to continue the current payroll levels will be identified in this column, eliminating 
the need to explain these items in a budget change.  

Remove Capital and One Time is populated upon checking Complete on the Operating 
Expense, Capital Assets, and Grants subschedules, if those subschedules contain AE or AF 
change packages. These amounts are summarized here, but are not entered or changed from 
the Budget Request Summary window. 

Base Budget Changes reflects all base budget changes that were entered on posting 
subschedules in either AA or AB change packages. These amounts are summarized here, 
but are not entered or changed from the Budget Request Summary window.   

Base Budget Request shows the agency’s total base budget request.  The general fund total 
in this column may not exceed the general fund budget limit determined by OMB.  No 
amounts are entered directly in this column – it is the sum of the 2019-21 Biennium 
Legislative Base, Payroll Difference from 2019-21, Remove Capital and 2021-23 Base 
Budget Changes columns. 

Optional Budget Changes reflects all optional budget changes – those that are assigned to 
an AC, AD or AG type change package and could not be included in the base budget 
request due to guideline limitations. These amounts are summarized here, but are not 
entered or changed from the Budget Request Summary window. 

Total Budget Request is the agency’s total budget request, including all optional 
adjustments. This is a calculated column resulting from the sum of the 2021-23 Base 
Budget Request and 2021-23 Optional Budget Changes columns. 
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Chapter Six: Budget Subschedules 
 
Chapter six provides information regarding the completion of budget subschedules referred to as 
“posting” subschedules. These subschedules post budget data directly to the Budget Request 
Summary once marked Complete on the Budget Request Checklist, thereby eliminating the need 
to reenter expenditure or funding amounts on the budget request for these items. Subschedules 
included in this chapter are: 

 
• Operating Expenses 
• Grants Summary 
• Capital Projects 
• Extraordinary Repairs 
• Equipment Over $5,000 
• IT Equipment and Software Over $5,000 
• Other Capital Payments 

 
The budget request is prepared at the budget account code level. The Revenue and Expenditure 
Accounts Listing provides the account codes that may be used in preparing the budget request. 
The listing also presents the detail account codes used in PeopleSoft. The detail accounts provide 
guidance in determining where to budget anticipated expenditures. 
 
Change packages must be created prior to entering expenditures and funding into posting 
subschedules. Use the Change Package Description tab in any posting subschedule to create as 
many change packages as are necessary to adequately identify various changes. Change 
packages created in one posting subschedule can also be used in other posting subschedules. 
 

Operating Expenses 
 
The Operating subschedule is used to enter budget changes for all operating account codes. 
Operating expenses may include equipment and repair items if those items are under 
$5,000. Corresponding freight and installation should be budgeted under the same line item 
the equipment item is budgeted. Because of the equipment’s portability, the price of each 
piece of a wall or desk station unit, such as Herman Miller units, should be considered 
individually when determining which line item to use. 

All computer software expenditures of $5,000 or less should be budgeted under the 
Operating Expense line item with the account code 531000 Supplies – IT Software using 
the Operating Expenses subschedule. 

All computer software expenditures greater than $5,000 should be budgeted under the 
capital assets line with account code 693000 IT Equipment/Software-Licenses > $5,000 
using the IT Equipment and Software over $5,000 subschedule.  

As noted in OMB policy number 211, the Statewide Conference Fund #212 is to be used 
only when the expenses of hosting a conference are NOT included in the agency 
appropriation. The statewide conference fund is NOT to be used for conferences that occur 
on a regular, ongoing basis. For such conferences, agencies are required to budget for them 
in the agency budget request. 

https://www.nd.gov/omb/sites/omb/files/documents/agency/financial/accountcodes.pdf
https://www.nd.gov/omb/sites/omb/files/documents/agency/financial/accountcodes.pdf
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Operating Expenses Window 

 
Navigation 
Log On =>Checklist=> Operating 
 
Purpose 
The Operating Expenses window is used to access the funding and expenditure windows 
for entering operating expense changes.  

Funding and Expenditures 
 
Have to enter a project to use for this subschedule. This only needs to be done once and can 
be used for all change packages in the Operating Expenses subschedule. 
 

 

Click the Change Package tab to enter the requested changes for each account code. Select 
the appropriate reporting level, Object Type and Line.  

Use the Add icon to insert a new line. Select the Change Package and Object Number from 
the drop down. 

• Base budget changes in the Base Budget Request column using change types AA 
or AB. 

• Optional budget changes in the Optional Request column using change types AC, 
AD, or AG.  

After saving the data, repeat the process to enter the remaining funding or expenditures for 
the change package, ensuring that Funding and Expenditures are in balance for each change 
package. 
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Grants Summary 

Grants Summary Window 

 

 

 

Grants Detail Window 
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Navigation 
Log On=>Checklist=> Grants Summary 

Purpose 
This window provides an agency-wide summary of the grants line item. 

Using the Window 
This window provides information on grants an agency provides to other entities. 
Information regarding each grant must be entered for both the current and the budget 
request biennium.  

Click Add and enter the required information. The description for the grant program should 
include the name of the program. The explanation should include the purpose of the grant 
and, unless listed elsewhere, the entity to which the money will be granted.  

Funding and Expenditures 
Select the grant on the Grants Summary Select tab. Choose the appropriate reporting level, 
and then select the Detail tab. Enter the current biennium appropriation and related funding 
source information for each grant previously added on the Grants Info window. Click the 
Change Package tab.  

Use the Change Package window to enter: 
• Base budget changes in the Base Budget Request column using change types AA 

or AB. 
• Optional budget changes in the Optional Request column using change types AC, 

AD, or AG. 

Click Add and select expenditures from the Object Type drop down. Select the appropriate 
line, project, change package description, the Grants account code, and enter the 
expenditure amounts. Save the data and then enter related funding source amounts ensuring 
that funding and expenditures are in balance for each change package. 

Capital Projects 
 
The capital projects subschedule is used to enter capital construction projects.  
 
Capital Projects - Definition 
Capital projects include spending for new construction, additions, and demolitions of 
buildings and infrastructure. Care should be taken when considering whether an 
expenditure is a capital project or an extraordinary repair.  
 
Extraordinary Repairs - Definition 
Extraordinary repairs are relatively large expenditures that benefit more than one operating 
cycle or period. If a repair will benefit several periods and/or extends the useful life of the 
asset, then the cost of the repair should be budgeted as an extraordinary repair within the 
capital assets line. Extraordinary repairs are entered in the extraordinary repair subschedule 
not the capital projects subschedule. 
 
Capital projects are requested and funded on a project-by-project basis. The capital budget 
request becomes a long-range planning document reflecting the State’s capital needs. A 
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long-range capital budget assists the executive and legislative branches of government in 
formalizing capital funding objectives, setting spending priorities, and efficiently allocating 
limited financial resources. By completing the capital budget, agencies are planning for 
future needs and communicating those needs to OMB and the Legislature. 

Criteria for prioritizing capital projects include items such as court-ordered or statutory 
(external) mandates; health, safety and environmental concerns; state policy direction; 
funding availability; and program needs. All capital projects for which funding is requested 
must meet ADA requirements. 

Capital Projects Window 
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Tip  The priority field is an important consideration for OMB when 
analyzing a capital project request. Make sure the appropriate 

number has been entered in this field. 
 

Navigation 
Log On =>Checklist=>Capital Projects 

Purpose 
The Capital Projects window summarizes and prioritizes capital projects. Costs or cost 
savings related to capital projects, such as salaries, operating expenses, and rent reductions 
are entered directly on the Capital Projects window for informational purposes. The 
anticipated direct costs for the project for the next three bienniums are also entered on the 
Capital Projects Information tab.  

Using the Window 
Enter the sequential number for the request. Next, enumerate the priority for this project, as 
ranked among all capital projects included in the budget request. To rank the capital project 
in relation to other non-capital budget needs, use the priority field on the Change Package 
Description.  
 

 

 

Enter a short description or title. Additional narrative, detailed explanations and cost 
benefit analysis must be entered using the Narrative tab.  

Enter the anticipated starting and ending dates for the project. Next enter the total number 
of bienniums over which the project will be completed and the total estimated cost of the 
project 

Answer Yes or No to the question related to ongoing savings or efficiencies.  

Complete the schedule of ongoing operating costs or savings related to this project. Savings 
should be shown as negative numbers. Include any additional FTE that will be requested to 
operate or maintain the facility.  

Explain operating costs or savings within the Narrative tab in the Cost Benefit Analysis and 
Project Specifications and Justification fields.  

Answer Yes or No to each of the questions in the next section of the window under the 
heading “Does this project:” Where necessary, offer additional explanation using the 
Narrative fields. 

The final section of the window relates to the State Facility Energy Improvement Program. 
Answer the questions in this section and click the Save icon. 

If the agency had a capital projects appropriation in the current biennium, a project with the 
description “Remove Current Biennium Capital Assets” must be entered on the Info tab. 
Use the Change Package tab, as explained below to enter a negative amount equal to the 
current biennium appropriation.  
 
See Chapter 8 for a detailed explanation of the Capital Projects narrative section.  

Funding and Expenditures 
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Tip  All capital projects included in the budget request will be entered as a 
change package. 

Select the project on the Select tab. Choose the appropriate reporting level, and then click 
the Change Package tab.  

Use the Change Package window to enter: 
• Removal of any capital projects authority in the current biennium. Use change type 

AF to remove the current biennium capital projects appropriation from the base. 
Assign changes to the project labeled “Remove Current Biennium Capital Assets.” 

• Base budget changes in the Base Budget Request column using change types AA 
or AB. 

• Optional budget changes in the Optional Request column using change types AC 
or AD. 

Click Add and select Expenditures from the Object Type drop down. Select the appropriate 
line, project, change package description, the land and buildings account code, and enter 
the expenditure amounts. Save the data and then enter related funding source amounts 
ensuring that funding and expenditures are in balance for each change package. 

Create separate Info tab entries and use the Detail tab to enter funding and 
expenditure amounts for projects that will take place during either of the two 
bienniums subsequent to the budget request biennium. These amounts are entered for 
planning purposes to inform OMB and the legislative branch of upcoming capital needs.  

 

 

Extraordinary Repairs 

The Extraordinary Repairs subschedule is used to enter major or extraordinary repair items. 
Extraordinary repairs are relatively large expenditures that benefit more than one operating 
cycle or period. If a repair will benefit several periods and/or extends the useful life of the 
asset, then the cost of the repair should be budgeted as an extraordinary repair within the 
capital assets line. Include all repairs to buildings and infrastructure involving dollar 
amounts in excess of $5,000 that are non-recurring in nature, and increase the value or 
service life of the asset.  

Individual items less than $5,000 should not be included in extraordinary repairs but should 
be budgeted for and paid out of the operating line. Projects of the same nature with an 
individual value of $5,000 or more can be aggregated and requested as one project.  

Ordinary repairs are expenditures made to maintain plant assets in operating condition and 
are less than $5,000. These repairs should not be budgeted as part of the capital assets line 
but rather should be budgeted under an account code within the operating line. Ordinary 
repairs are preventive maintenance, normal periodic repairs, replacement of parts, 
structural components, and other activities such as repainting, and equipment adjustments 
that are needed to maintain the asset so that it continues to provide normal services 
Examples of ordinary repairs include: 

• roof and/or flashing repairs 
• window repairs and glass replacement 
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• painting 
• masonry repairs 
• floor repairs 

 
Extraordinary Repairs Window 

 
Navigation 
Log On =>Checklist=>Extraordinary Repairs 

Purpose 
The Extraordinary Repairs window summarizes and prioritizes extraordinary repair 
projects. Amounts requested for the upcoming biennium are entered on the Change 
Package tab.  

Using the Window 
Enter the sequential number of the request and the priority number for this project, as 
ranked among all extraordinary repair items included in the budget request. To rank the 
repair in relation to other non-capital budget needs, use the priority field on the Change 
Package Description.  

Enter a short description or title.  

Enter the anticipated starting and ending dates for the repair project. Next enter the total 
number of bienniums over which the project will be completed and the total estimated cost 
of the project.  

The final section of the window relates to the State Facility Energy Improvement Program. 
Answer the questions in this section, Save, and then insert the budget data for this project 
by using the Change Package tab. 

If the agency had an extraordinary repairs appropriation in the current biennium, a project 
with the description “Remove Current Biennium Capital Assets” must be entered. Use the 
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Tip All extraordinary repair projects included in the budget request  
must be entered as a change package. 

Change Package tab, as explained below to enter a negative amount equal to the agency’s 
current biennium appropriation.  
 
Funding and Expenditures  
Select the project on the Select tab. Choose the appropriate reporting level, and then click 
the Change Package tab.  

Use the Change Package window to enter: 
• Removal of any extraordinary repair authority in the current biennium. Use change 

type AF to remove the current biennium extraordinary repairs appropriation from 
the agency’s base budget. Assign changes to the project and enter the negative 
amount in the Remove Capital column. 

• Base budget changes in the Base Budget Request column using change types AA 
or AB. 

• Optional budget changes in the Optional Request column using change types AC 
or AD.  

  

 

Click Add and select expenditures from the Object Type drop down. Select the appropriate 
line, project, change package description, the extraordinary repairs account code, and enter 
the expenditure amounts. Save the data, and then enter related funding source amounts 
ensuring that funding and expenditures are in balance for each change package. 
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Other Capital Payments  

The Other Capital Payments window is used to enter: 
• Department of Transportation road and highway projects. 
• State Water Commission water projects.  
• Special assessments. 
• Bond payments. 
• In lieu of tax payments. 

 

Other Capital Payments Window 

 
 
Navigation 
Log On =>Checklist=>Other Capital Payments 

Purpose 
The Other Capital Payments window summarizes and prioritizes other capital payment 
items.  

Using the Window 
Enter the sequential number of the request and priority number for this project, as ranked 
among all other capital payment items included in the budget request. To rank the item in 
relation to other non-capital budget needs, use the priority field on the Change Package 
Description.  

Enter a short description or title.  
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From the dropdown, select Bond Payments, Special Assessment Payments, In Lieu of Tax 
Payments, or Other. If other, explain using the Narrative tab. 

If the agency had an other capital payments appropriation in the current biennium, a project 
with the description “Remove Current Biennium Capital Assets” must be entered. Use the 
Change Package tab, as explained below, to enter a negative amount in the Remove 
Capital column equal to the current biennium appropriation.  
 
Funding and Expenditures  
Select the project on the Select tab. Choose the appropriate reporting level, and then select 
the Change Package tab.  

Use the Change Package window to enter: 
• Removal of any other capital payments authority in the current biennium. Use 

change type AF to remove the current biennium other capital payments 
appropriation from the base budget. Assign changes to the project labeled “Remove 
Current Biennium Capital Assets” and enter the negative amount in the Remove 
Capital column. 

• Base budget changes in the Base Budget Request column using change types AA 
or AB. 

• Optional budget changes in the Optional Request column using change types AC 
or AD. 

Click Add and select expenditures from the Object Type drop down. Select the appropriate 
line, project, change package description, the other capital payments account code, and 
enter the expenditure amounts. Save the data, then enter related funding source amounts 
ensuring that funding and expenditures are in balance for each change package. 
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Equipment Over $5,000 
 

Equipment Over $5,000 Window  
 

 
 
Navigation 

Log On =>Checklist=>Equipment Over $5,000 

Purpose 
The Equipment Over $5,000 window is used to enter all non-IT equipment in excess of 
$5,000. Individual items less than $5,000 should be budgeted for and paid out of the 
operating line.  

Using the Window 
Click Add and enter the sequential number for the request and priority number for this 
project, as ranked among all other Equipment Over $5,000 items included in the budget 
request. To rank the item in relation to other non-capital budget needs, use the priority field 
on the Change Package Description.  

Enter a short description or title of the equipment. The Explanation field should include a 
description of the equipment and its purpose. Similar equipment with an individual value of 
$5,000 or more can be aggregated and requested under one description. However, adequate 
detail needs to be provided so that the exact type and quantity of equipment can be 
determined. For example, 5 riding lawn mowers is fine, but lawn maintenance equipment is 
too general. 

Indicate if the proposed purchase is to replace existing equipment. 
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Indicate the estimated useful life of the new equipment. Enter the unit price and the number 
of units in the base and optional requests. 

If the agency had any equipment over $5,000 appropriation in the current biennium, a 
project with the description “Remove Current Biennium Capital Assets” must be entered. 
Use the Change Package tab, as explained below to enter a negative amount in the Remove 
Capital column equal to the current biennium appropriation.  
 
Funding and Expenditures  
Select the project on the Select tab. Choose the appropriate reporting level, and then click 
the Change Package tab.  

Use the Change Package window to enter: 
• Removal of any equipment over $5,000 authority in the current biennium. Use 

change type AF to remove the current biennium equipment over $5,000 
appropriation from the base. Assign changes to the project labeled “Remove 
Current Biennium Capital Assets” and enter the negative amount in the Remove 
Capital column. 

• Base budget changes in the Base Budget Request column using change types AA 
or AB. 

• Optional budget changes in the Optional Request column using change types AC 
or AD. 

Click Add and select expenditures from the Object Type drop down. Select the appropriate 
line, project, change package description, the Equipment Over $5,000 account code, and 
enter the expenditure amounts. Save the data, and then enter related funding source 
amounts ensuring that funding and expenditures are in balance for each change package. 
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IT Equipment and Software Over $5,000 

IT Equipment and Software Over $5,000 Window  

 
Navigation 
Log On =>Checklist=>IT Equip and Software Over $5,000 

Purpose 
This window provides detail supporting the request for IT equipment and software in 
excess of $5,000. Individual IT equipment and software items less than $5,000 should be 
budgeted for and paid out of the operating line.  

Using the Window 
Click Add and enter the sequential number of the request and the priority number for this 
project, as ranked among all other IT equipment over $5,000 items included in the budget 
request. To rank the item in relation to other non-capital budget needs, use the priority field 
on the Change Package Description.  

Enter a short description or title. The Explanation field should include a description of the 
item and its purpose. Similar equipment with an individual value of $5,000 or more can be 
aggregated and requested under one description. However, adequate detail needs to be 
provided so that the exact type and quantity of equipment can be determined.  

Indicate if the proposed IT equipment purchase is to replace existing equipment. 

Enter the unit price and the number of units in the base and optional requests. 

If the agency had any IT equipment over $5,000 appropriation in the current biennium, a 
project with the description “Remove Current Biennium Capital Assets” must be entered. 
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Use the Change Package tab, as explained below to enter a negative amount in the Remove 
Capital column equal to the current biennium appropriation.  
 
If a request is part of a large IT project, use a change description entitled “IT – (Name of 
Large IT Project)”. That same change description title and number will be included in the 
Large IT Project Subschedule. Use the same change package for all related costs 
throughout all subschedules such as the Operating Subschedule for IT contractual and 
travel expenses, etc. 
 
Funding and Expenditures 
Select the project on the Select tab. Choose the appropriate reporting level, and then click 
the Change Package tab.  

Use the Change Package window to enter: 
• Removal of any IT equipment and software over $5,000 authority in the current 

biennium. Use change type AF to remove the current biennium IT equipment and 
software over $5,000 appropriation from the base. Assign changes to the project 
labeled “Remove Current Biennium Capital Assets” and enter the negative amount 
in the Remove Capital column. 

• Base budget changes in the Base Budget Request column using change types AA 
or AB. 

• Optional budget changes in the Optional Request column using change types AC 
or AD. 

Click Add and select expenditures from the Object Type drop down. Select the appropriate 
line, project, change package description, the IT equipment and software over $5,000 
account code, and enter the expenditure amounts. Save the data and enter related funding 
source amounts ensuring that funding and expenditures are in balance for each change 
package. 
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Tip Subschedule copy can be used to transfer information from the 2019-21 request 
to the 2021-23 budget request. See Chapter 2 for instructions. 

Chapter Seven: Supplementary Subschedules 
 
This chapter provides information regarding the completion of supplementary, or “non-posting,” 
subschedules. These subschedules do not post budget data to the Budget Request Summary. The 
schedules are used to provide supplementary and supporting information. Subschedules included 
in this chapter are: 

• Large IT Projects 
• General Fund Collections 
• Licensing, Regulation, Inspection 
• Lease Purchase Agreements 
• Continuing Appropriations 
• Special Fund Balance 
 

 

Lease Purchase Agreements 
 
Lease Purchase Agreements Window 
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Navigation 
Log On =>Checklist=>Lease Purchase Agreements 
 
Purpose 
This window allows agencies to enter required information relating to any existing or 
proposed capital or operating lease or debt financing arrangement for assets or services, 
excluding real estate, with an original value of at least $50,000. This reporting requirement 
also applies to any group of assets or services comprising a single system with a combined 
value of at least $50,000. As provided in subsection 8 of NDCC Section 54-44.1-06, the list 
of assets and services must include any assets or services acquired in the current biennium 
and any anticipated to be acquired during the budget request biennium. 

Using the Window 
Click Add to begin entering information for each financing agreement. Use the following 
definitions in completing the fields on this window. Completion of all fields is required 
 
Number 
Unique sequential number identifying each lease or financing agreement. 
 
Start and End Dates 
Enter the inception and termination dates of the lease or financing agreement. 

 
Description 
Include a short summary of what was or is proposed to be acquired through a lease or debt 
financing arrangement. 
 
Explanation 
Provide an explanation of the factors that led to the decision to lease rather than purchase the 
item.  
 
Monthly Payment 
Enter the amount to be paid monthly pursuant to the lease or financing agreement. 
 
Original Value 
Provide the value of the item at the beginning of the lease or financing agreement. 
 
Additional required fields include the number of months the lease will be in effect during the 
budget biennium, and indicating if the leased asset replaces an existing leased asset. 
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Licensing, Regulation, Inspection 
 

Licensing, Regulation, Inspection Window 
 

 
 
Navigation 

Log On=>Checklist=> Licensing, Regulation, Inspection 

Purpose  
This window provides financial detail on licensing, regulation, and inspection activities, as 
required by NDCC Section 54-06-04.1. 

Using the Window 
From the Select tab, click the Add button to insert a new item for each activity. All fields 
are required. For each license, inspection, or regulation fee collected during the previous 
biennium, enter: 

• a unique numerical identifier 
• a description 
• statutory authority under which it is collected 
• the date the fee was last changed 
• the fund in which the revenue is deposited; if deposited into the general fund, select 

“001” 
Enter prior biennium actual figures and current/budget biennium estimates for: 
• number of items processed  
• charge per item 
• costs associated with providing the licensing, inspection, or regulation service. 

Total costs should include indirect costs as well as direct costs.  
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If the rate charged per item changed during the biennium, enter a separate record to show 
the number of items and total collection for each individual rate charged. The total cost 
information should be prorated among different rates, if necessary. 

Example 

If, during the first 6 months, the fee for a specific inspection was $100 and for the 
remaining 18 months, the fee was $125 per inspection, the total costs of $100,000 would 
be prorated; $25,000 for the first 6 months and $75,000 for the next 18 months. 

 
 
General Fund Collections 

 General Fund Collections Window 

 
 
Navigation 
Log On=>Checklist=>General Fund Collections 

Purpose 
This window lists the various fees that an agency collects and deposits into the general 
fund. OMB uses this information for the revenue forecast. 

Taxes and fees collected and deposited in the general fund should be included on this form, 
regardless of dollar amount.  

The following major revenue sources should not be included on the schedule: Sales and 
Use Tax, Individual Income Tax, Corporate Income Tax, Business Privilege Tax, Cigarette 
and Tobacco Tax, Oil and Gas Production Tax, Oil Extraction Tax, Coal Conversion Tax, 
Insurance Premium Tax, Wholesale Liquor Tax, Gaming Tax, Interest Income, Mineral 
Leasing fees, and Gas Tax administration. 
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Using the Window 
Click Add to insert a new item for each type of general fund collection. Enter a unique 
sequential number, description, actual collections for the previous biennium, estimated 
collections for the current biennium, anticipated collections for the subsequent biennium, 
and the statutory authority. All fields are required. 
 
The explanation field should detail any major variances in biennial collections. If there are 
recent or proposed changes to the fee that should be noted by OMB in preparing the 
revenue forecast, please use the explanation field to note such items. 

 

Continuing Appropriations 
Continuing Appropriations Window 

 
Navigation 
Log On=>Checklist=>Continuing Appropriations 
 
Purpose 
This window is used to collect information regarding continuing appropriations authorized 
for state agencies. The report must include justification for continuing the authority, as well 
as actual and anticipated expenditures, revenue, transfers, and fund balances. 
 
Using the Window 
Click Add and, for each continuing appropriation authorized, enter the required information: 

• unique identifying number 
• short description 
• statutory authority 
• number and name of special fund where revenues and expenditures are recorded 
• actual beginning balance, revenue/transfers and expenditures for the 2015-17 and 

2017-19 biennia 
• estimated revenue/transfers and expenditures for the 2019-21 and 2021-23 biennia 
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Click the Narrative tab to enter the continuing appropriation justification for each continuing 
appropriation. 
 
 

Special Fund Balance 
 
Navigation 
Log On=>Checklist=>Special Fund Balance 
 
Purpose 
The purpose of this window is to record revenues, transfers, and expenditures relating to 
special funds. 
 
Using the Window 
The special fund balance subschedule is used for appropriated special funds only. If other 
funds appear on this subschedule, such as those for which a continuing appropriation exists, 
contact the assigned OMB budget analyst. Note: For special funds shared with another 
agency, discuss the issue with the assigned budget analyst and coordinate budgeted 
expenditures with the other agency. 
 
The information on the special fund balance subschedule windows is used to generate special 
fund statements for all special funds from which an agency receives appropriations. The 
subschedule is divided into two tabs: Summary and Detail. No information is entered on the 
Summary window. This window summarizes information entered elsewhere. The Detail 
window is used to enter information relating to a particular special fund selected on the 
Summary window. The information contained on each window is summarized below: 
 
Note: You may need to uncheck the “Display Only Active Funds” box to see all 
available funds. 
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Special Fund Balance Summary Window 
 

 
 
Special Fund Balance Summary  
2019-21 Beginning Balance - OMB enters this amount into IBARS. If a beginning balance 
amount needs to be changed, contact the assigned OMB budget analyst. 
 
2019-21 Net Trans./Rev. - This amount is the net result of Transfers In, Transfers Out, and 
Revenue amounts entered on the detail window.  
 
2019-21 Appropriations - The amount is the total of all current biennium appropriations from 
this fund, as indicated in the Budget Request Summary window. Changes to this amount 
must be made on the Budget Request Summary window. When the Budget Request 
Summary subschedule is marked complete, the appropriation amount will post to this 
window. However, if the appropriation amount does not reflect estimated expenditures for 
the 2019-21 biennium, an adjustment to the appropriation can be entered on the Detail 
window.  
 
2019-21 Estimated Expenditures - This amount is the total of all current biennium 
expenditures from this fund, as shown on the Budget Request Summary window. Changes to 
this amount must be made in the Budget Request Summary. When Budget Request Summary 
is marked complete, the expenditures will post to this window. 
 
2021-23 Beginning Balance - This is a calculated amount based on the amounts entered in 
the preceding columns. 
 
2021-23 Net Trans./Rev. - This amount is the net result of Transfers In, Transfers Out, and 
Revenue amounts entered on the Detail window. 

 
 



Chapter Seven: Supplementary Subschedules            April 13, 2020 
 

7 - 8 

2021-23 Budget Request - This amount represents all expenditures from this fund posted 
from the Budget Request Summary once that subschedule is checked to complete. 

 
2021-23 Ending Balance - This is a calculated amount based on the amounts entered in the 
preceding columns. 
 
Special Fund Balance Detail Window 

 
 
Special Fund Balance Detail  
Transaction Object - This dropdown field is used to select the appropriate revenue or transfer 
account code. In addition to detailed PeopleSoft revenue codes, the list includes account 
F7998 – Transfer Out and F7999 – Adjustment to Appropriation. Use account F7998 
whenever funds are budgeted to be transferred out of the special fund to another special fund 
or the general fund. Use this account whenever a fund is selected in the Transfer Fund field. 
Use account F7999 whenever an amount is entered in the Adjustments to Appropriations 
column. 
 
Transfer Fund -  Use this field to select a fund to which moneys will be or have been 
transferred out of the fund. For Transfers In, use the appropriate revenue Transaction Object 
and leave the Transfer Fund field blank. If a fund is selected in the Transfer Fund field, the 
Transaction Object selected should be F7998 – Transfer Out.    NOTE:  By default, this 
field is disabled and will not appear in the window.  Contact the assigned OMB budget 
analyst to enable the field.  
 
2019-21 Revenue/Transfer - This field is used to enter revenue amounts and transfers 
estimated to be received into the fund during the 2019-21 biennium. Select the applicable 
account from the transaction object drop down.  

 



Chapter Seven: Supplementary Subschedules            April 13, 2020 
 

7 - 9 

2019-21 Transfers Out - This field is used to enter amounts estimated to be transferred from 
the fund. Select the appropriate transaction object and select the receiving fund from the 
transfer fund drop down list. 

 
2019-21 Net Trans./Rev. - This is a calculated field representing the net amount of Revenue 
and Transfers Out.  
 
Adjustments to Appropriations - Use this field to adjust appropriation amounts to reflect 
anticipated expenditures. The estimated expenditure amount total appears only on the Special 
Fund Balance Summary window.  
 
2019-21 Revenue - This field is used to enter revenue amounts and transfers estimated to be 
received during the 2021-23 biennium. Select the applicable account from the transaction 
object drop down.  
 
2021-23 Transfers Out - This field is used to enter amounts estimated to be transferred from 
the fund. Select the appropriate transaction object, and select the receiving fund from the 
transfer fund drop down list. 
 
2021-23 Net Trans./Rev. - This is a calculated field representing the net amount of Revenue 
and Transfers Out.  
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Large IT Projects 
 Large IT Projects Window 

 
 

Navigation 
Log On=>Checklist=>Large IT Projects 
 
Purpose 
This subschedule is used to provide detailed project direct costs and post-implementation 
costs/savings in the Project tab. Additionally, explanatory information is captured in the 
Narrative tab. 
 
Using the Window 
Large IT Projects Select Window 
Click the Add icon to add a record for each large IT project in the budget request. 
 
Project Window 
Selecting the project on the Select window opens the Project window. All fields in the 
window must be completed. 
 
Enter a unique identification number and short description or title for each project. Indentify 
the change package group, type and number where the project budget is requested. Use a 
change package description entitled “IT – (Name of Large IT Project)”. That same change 
description title and number will be included in the Large IT Project Subschedule. Use the 
same change package for all related costs throughout all subschedules such as the Operating 
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Subschedule for IT contractual and travel expenses, etc. Enter the estimated project planning 
start date and project completion date. Answer the questions regarding replacement, upgrade 
and new development. Enter the anticipated project costs and funding sources for the 2021-
23, 2023-25 and 2025-27 biennia. Identify the number of FTE that are needed for this 
project. Enter estimated related post-implementation costs or savings that will be incurred in 
the 2023-25 and 2025-27 biennia. Expenditures should be broken down into Salaries/Wages, 
Operating Expenses, and Capital Assets, as well as identifying planned funding sources and 
any staffing needs. 
 
Narrative Window 
Enter the anticipated benefits, detailed project description, project risks, and proposed 
solution as provided to the Statewide Information Technology Advisory Committee 
(SITAC). 

 



Chapter Eight: Narrative               April 13, 2020 
 

8 - 1 

Chapter Eight: Narrative 
 
This chapter provides information on the various narrative input windows. Agency-wide and 
program specific narrative fields are accessed via the Narrative subschedule on the Budget 
Request Checklist. Other narrative fields are accessed through the Narrative tab accessible on the 
subschedule to which the narrative relates. 
 
The narrative fields included in this chapter are: 
 

• Agency-wide narrative 
o Description 
o Future Critical Issues 
o Major Accomplishments 
o Mission Statement 
o Performance Measures 
o Statutory Authority 
 

• Program narrative 
o Explanation of Program Costs 
o Goals and Objectives 
o Performance Measures 
o Statistical Data 

 
• Capital Projects 

o Project Specifications 
o Cost Benefit Analysis 

 
• Continuing Appropriations 

o Continuing Appropriation Justification 
 
• Change Package Description 

o Change Package Narrative 
 
• Large IT Projects 

o Anticipated Benefits 
o Detailed Project Description 
o Project Risks 
o Proposed Solution 
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Tip: Narrative should be concise and complete, but not duplicative. 

 

Tip: To save time, the subschedule copy function can be used to copy narratives from the previous 
biennium 2019 R02 version (as included in the Governor’s budget) to a current biennium “A” version. 

Please see Chapter 2 for additional instructions. 

Agency and Program Narrative  

Navigation 
Log On=>Checklist=>Narrative 

Purpose 
The Narrative window is used to enter various narrative data at the agency and program 
level.  

Using the Window 
From the drop down lists, select the agency or program level and the narrative title to be 
completed. If at a program level, also select the appropriate program. The narrative input 
for programs is completed at the budget level, even if the version is being prepared at an 
accounting level. When completing each of the program narrative items, total costs for a 
budget level should be considered, not costs for individual department IDs. 

IBARS contains font specifications for font type (Arial), size (8), and color (Black). For 
data copied into IBARS, the saving process is completed in two steps: 

1. Click Save – Font size, type, and color are checked and changed to meet 
specifications.  
2. Click Save - Data is saved in the database  

 
Dialogue boxes will appear after each step indicating that edits have been made and 
prompting the user to click the Save icon.  The process is complete when the Save 
Succeeded message appears.  
 
 Even if narrative is subschedule copied from the previous biennium and no changes are 
made, each narrative field must be reviewed and re-saved to apply the font edits, 
continuing until the Save Succeeded message appears. 
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Agency-wide Narrative Fields 

 
 
The Agency Description should indicate what an agency does and for whom it is done. The 
Office of Management and Budget has edited this section for consistency across state 
government. Please use the Agency Description in the R02 version from the previous biennium 
unless agency functions have changed considerably. 

Agency Future Critical Issues should include a statement relative to future needs of the agency 
as a result of legal, environmental, economic, and other changes, such as the uncertainty of 
federal funding levels. 

Agency Major Accomplishments should include initiatives or activities the agency has 
completed in the 2019-21 biennium and would like to highlight for policy makers. 

The Agency Mission Statement is a broad statement of the overall purpose for an agency’s 
existence. Agencies with an established strategic plan and mission statement should enter the 
agency mission statement developed through the strategic planning process. Agencies that do not 
have an established strategic plan should enter a broad statement of the overall purpose for the 
agency’s existence. 

Agency Performance Measures should include agency-level performance measurements that 
are linked to strategic operational planning. Reported performance measures should be, to the 
extent possible, outcome measures. The measures included here should be significant to 
understanding the performance of an agency. The number of agency-level performance measures 
should be limited to no more than five. These measures should be the most significant measures 
for the agency.  

If agency-level performance measures have been established, this narrative field should also 
include a discussion of the agency’s progress meeting each measure, including comparisons to 
the previous two or three years, if available, as well as the target or benchmark the agency is 
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Tip: Program level performance measures should be reported in the program narrative 
and not repeated in the agency narrative. 

striving to achieve. The narrative should also include how the benchmarks were determined. For 
example, were they established internally, required by the federal government, or determined by 
other means? 

This is a mandated field that requires that data be input in order for an agency to validate and 
submit the budget. However, it is not mandatory that an agency report performance 
information. Should an agency choose not to report, the narrative can simply state that 
performance measures and results reporting are not currently used by the agency. 
 

Agency Statutory Authority is the North Dakota Century Code citation that establishes and 
governs the agency. The Office of Management and Budget has edited this section for 
consistency across state government. Please begin by using the Statutory Authority in the R02 
version from the previous biennium, then update as necessary to ensure newly enacted statutory 
authority is listed. 
 



Chapter Eight: Narrative               April 13, 2020 
 

8 - 5 

Program Narrative 
 

 
Explanation of Program Costs should include an explanation of the major cost factors for the 
program. Include quantitative information such as projected caseloads, rates and usage. Identify 
any circumstances causing unusual spending patterns over the past three years. Information 
regarding increases or decreases in current spending, or budget changes, should not be included 
here. Budget changes should be addressed in the Budget Change Description window. 

Program Goals and Objectives should be entered here. A goal is a long-term (multi-year) 
vision of the future; the general end towards which efforts are directed. A program objective is 
the ultimate purpose of a program stated in terms of a measurable result.  

Depending on an agency’s strategic plan or other planning process, a program may not have both 
goals and objectives. An agency should enter information on the program goals and objectives in 
the format established through its planning process. Using the Fiscal Management program of 
OMB as an example, the program goal is to deliver quality customer service and manage 
available resources. The program objective is to produce a comprehensive financial report; 
complete the Governor’s biennial budget recommendation; and provide timely, quality support to 
state agencies and institutions for all financial and budget transactions. 

Program Performance Measures should include measures established in a strategic plan or 
other process that reflect the results of program activities. Reported performance measures 
should be significant in understanding the performance of the program. The number of program-
level performance measures should not exceed five. This narrative field should also include 
historical information on how well the program is doing in meeting its measures as well as the 
target or benchmark the program is striving to achieve. The narrative should also include the 
source of the benchmark. 

Program Statistical Data should include any statistics about the program that are pertinent, 
such as the number of people the program serves or the number of documents processed.  
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Capital Projects 
 

 
 
Navigation 
From the Capital Projects Select window, click on the appropriate capital project, and then select 
the Narrative Input tab. Two narrative fields, Project Specifications and Cost Benefit Analysis, 
are required for all capital projects, and can be accessed from the Narrative Title drop down 
window. 
 
Project Specifications and Justification 
Questions that should be considered by the agency when preparing the Project Specifications and 
Justification narrative include the following: 

• What evidence is there that this project needs to be done? 
• What will happen if the state does not fund this project? 
• Has adequate planning for this project been done? Should a planning appropriation be 

made first? 
• Can another resource be used to finance this project? Can the cost be shared? 
• Would it be cheaper to renovate or remodel an unused facility? 
• Can this project wait until next biennium? 
• Before considering new requests, have current facility needs been met? 
• Would this project be necessary if the size of government decreased, if population 

declined, if a technological breakthrough occurred, or demand declined? If not, what is 
the likelihood of any of these happening in the next ten years? 

• Are there alternative funding scenarios for this project? Such as: General obligation 
bonds? Revenue bonds? Direct appropriation? User fees? Leaseback agreement? Rent? 

• What are the operating and maintenance costs over the life of this project once it is 
completed? Are they reasonable? Will it require additional general fund commitments? 
Can total costs be saved by spending more at the outset of the project to reduce operating 
costs later (e.g., through redesign of a facility)? 

• What would the proponents of this project cut if they could receive only 80 percent of 
requested funding? 

• Have all the costs of this project been presented, including construction costs, architects' 
fees, contingency fees, construction supervision fees, equipment, insurance and bid costs, 
and site acquisition costs? 

• What are the economies (dis-economies) of scale? Would a bigger facility be cheaper per 
client served or per personnel housed? If a bigger facility is built, can part of the space be 
rented? 

• Who is against this project? Why? Do they have valid concerns? 
• How do recent/proposed federal budget and tax actions affect the need for and cost of this 

project? 

The questions listed above were adapted from a report published by the National Conference of 
State Legislatures entitled, "Capital Budgeting and Finance: The Legislative Role."  
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Cost Benefit Analysis Narrative – Statutory Requirement 
In accordance with NDCC 54-44.1-16, a cost benefit analysis must be completed for each new 
building construction project included in budget requests. The analysis must review options for 
co-locating with other state agencies, departments, or institutions and consider information on 
related technology costs and savings. 
 
Continuing Appropriations 
 

 
From the Continuing Appropriations window, choose the correct continuing appropriation, and 
then click the Narrative tab to select the Narrative title Continuing Appropriation Justification 
from the drop down. Use this field to explain the justification to be conveyed to policymakers 
regarding the need to continue the statutory authority for this continuing appropriation. 
 
Change Package Description 
 

 
From any posting subschedule or the Budget Request Summary, click the Change Package 
Description tab, and then click the Narrative tab. Choose the appropriate change package from 
the Change Package Description drop down. Use this window to explain the reasons for the 
change package and explanations for the changes at the account code detail level, where 
appropriate. Do not repeat the same narrative as the short description. 
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Large IT Projects 
 

 
From the Large IT Projects Select tab, choose a project, and then click the Narrative tab. Choose 
the appropriate Narrative Title from the drop down. Separate narrative sections must be provided 
for the anticipated benefits of the project, a detailed project description, risks associated with the 
project, and the proposed solution. Narrative should be similar to that provided to the interim 
State Information Technology Advisory Committee (SITAC). 
 



Chapter Nine: Completing the Budget Request        April 14, 2020 
 

9 - 1 

Chapter Nine: Completing the Budget Request 
 
Chapter nine explains the final steps involved in completing the budget request, validating, and 
submitting the budget. 
 

Validating the Budget 
 
Agencies can run two reports to help to ensure the budget request will submit correctly. They 
are: 

• SR06 Budget Validation Report – This is the standard report included in the IBARS 
software to address basic validation issues required by all states, such as balancing of 
expenditures and funding.  

• CRVA Validate Agency Version report - The CRVA report is custom designed for 
North Dakota to address validation issues unique to our implementation of the IBARS 
application. 

 
SR06 Budget Validation Report 

 
Navigation  
Log On=>Publications tab=>Standard Reports=>SR06 Report 
 
Purpose 
IBARS includes a balancing or validation feature to ensure the accuracy and completeness 
of the budget data. If funding and expenditure amounts are out of balance, a notice such as 
the one shown below appears when a subschedule is marked to complete. The SR06 report 
provides the explanation necessary to correct the imbalance or other issue.  

 

Using the Report 
When a subschedule is completed, mark it Complete on the Checklist. If the subschedule is 
out of balance and an error message similar to the one above appears, view the SR06 
report. 

The subschedule to which the validation error relates is listed first for each item. Also 
shown are the reporting level and a description of the error.  

After returning to the appropriate subschedule to correct the error, return to the Checklist 
and again select Complete for that subschedule. If the subschedule still does not pass 
validation another error message will appear indicating the next component that is out of 
balance or incomplete. 

The SR06 report will need to be rerun after each error is corrected. 
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  Tip If, subsequent to marking an item Complete, the user revises a 
 window, the indicator automatically reverts to “Not Complete” on  

the Budget Request Checklist. Once revisions are finished,  
mark the item Complete and continue validation. 

 
  Tip The on-line balancing process handles only one error at a time 

 until all budget errors are resolved. An alternative is to print  
the Validation Report so that all errors are displayed and 

 can be resolved at once. 

 

 

 

 

The agency must continue this process for all subschedules listed in the Checklist until all 
items are checked complete. Only at this point is the user able to submit the budget to 
OMB. Contact the assigned OMB budget analyst for any questions on this report. 

CRVA – Validate Agency Version Report 
 
Navigation  
Log On=>Publications=>Agency Reports=>CRVA Validate Agency Version Report 
 
Purpose 
Similar to the SR06 report is the CRVA – Validate Agency Version report. This report lists 
additional items that will need to be corrected in the budget prior to submission. Items may 
appear on this report even though the SR06 report indicates all validation issues have been 
addressed and all subschedules are marked to complete.  

Using the Report 
A variety of items may appear on this report. Contact the assigned budget analyst for 
assistance in resolving any issues appearing on this report.  
 

Submitting the Budget Request 
 

Navigation Path 
Log On=>Versions Tab=>Submit Link 

Purpose 
Submitting the budget creates a budget request B version that can be viewed by OMB and 
Legislative Council. 

Using the Window 
From the Versions window, click on the Submit link associated with your completed 
Agency Version. If any budget window is out of balance or incomplete, no submit link will 
be available next to the version. An hourglass displays until the budget request version is 
created. The agency is able to submit only one budget version. The agency now has a B 
version that is the official Budget Request for the agency. 

After submission, the agency is able to view the submitted or B Version, but is not able to 
modify or delete it. The A Version the agency used to create the submitted version is still 
accessible to the user. The submit link will remain next to the version. However, it is a 
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good idea to make note of which A version was submitted by changing the version’s title. 
It is recommended that no additional changes be made to the A version that is submitted. 
Before trying different scenarios, copy the submitted A version to a new A version. 

If, for any reason, a change to the submitted budget request is necessary, contact the 
assigned budget analyst. If the change is substantial and the OMB system administrator has 
to delete the budget request version, the agency will have to repeat the budget submission 
process. 



Chapter Ten: Reports           April 14, 2020 
 

10 - 1 

Chapter Ten: Reports 
 
This chapter describes the various reports available through IBARS and procedures for printing 
or viewing them. Many of the reports can be viewed or printed at either the agency level or at the 
program level. Reports can be generated in HTML, PDF, or CSV output types. Sample reports 
are located at the end of this chapter.  
 
Reports are located in Publications tab, by selecting either Standard or Agency from the Select 
dropdown list. 

Reporting 
 Agency Reports: 

 CR01 Salary Budget 
 CR02 Position Funding 
 CR03 Schedule Information 
 CRSR Subschedule Reports 

SP Subschedule Report 
CRVA Validate Agency Version 

 CR06 Agency Special Fund Report 
 CR07 Agency Grants Summary Report 
 CR08 Agency Extraordinary Repairs Report 
 CR09 Agency Equipment > $5,000 Report 
 CR10 Agency IT Equipment > $5,000 Report 
 CR11 Compensation Package Validation 
 CR12 Salary Compensation 
 CRCP Capital Projects Agency 
 CRCS North Dakota Change Package Summary 
  
 Standard Reports: 
  SR01 Reporting Levels 
  SR04 Change Package Summary 
  SR05 Budget Request Summary – Reporting Level 
  SR06 Budget Validation 
  SR07 Version Comparison 
  SR12 Pay Plan Comparison 
  SR13 Personal Services Budget 
  SR15 Sample Graph (not used) 
  SUBSCH1 Subschedule Info  
  NARR Narrative Reports 

 
Navigation 
Logon=>Publications=>Agency or Standard 
 
Using the Windows 
From the list of reports, click the report ID of the selected report, choose necessary fields, 
and click the “OK” at the bottom of the screen. 
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 Tip  If the Code Type Rollup box is checked, select (All) from the 
reporting level dropdown for an agency level report and a 
report for every rollup level. Select one of the two agency 
names for a report at the agency level OR select individual 
rollup level reports. 

 
 If the Code Type Rollup is unchecked: select (All) for reports 

of every reporting level or select the desired individual 
reporting level. 

 

From the “Report Name” drop down list, select the desired version of the report. For 
certain reports the user will notice various choices in the Report Name drop down. These 
are previously saved report profiles with preset column selections.  
 
Choose the desired report profile from the dropdown, or rename the report to have that 
name appear on the printed report. 
 
If the user desires the report at the agency level or a rollup reporting level, place a 
checkmark in the Code Type Rollup box. Leave the check box blank to choose a report at 
a lower reporting level. 
 
 
 
 
 
 
 
 
 

Select the columns desired to appear on the report using dropdowns labeled Columns  
2 - 7.  
 
In the Code 1 dropdown, select Major Program to run a report at the major program level. 
Code 2 is not used. 
 
Click OK to generate the report.  

 

Report Profiles 

Creating a New Profile 
If the user wishes to save certain column or other report settings, a report profile should be 
created. 
 
Select an existing report file from the Report Name dropdown and click the Add icon. When the 
Profile Edit field appears, enter a new name for the profile. Select the desired report settings, 
such as code type rollup, subschedule, reporting level, and columns. Finally, click the Save icon 
on the action bar. The new profile will now appear in the Report Name dropdown. 
 
Renaming a Profile 
Select the profile from the Report Name dropdown. In the Edit Profile Name box, enter the new 
name for the selected profile. Click the Rename checkbox. Click the Save icon, and the profile 
name will immediately update in the Report Name dropdown list. 
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Tip  In order to generate a report for the entire agency as well as 
individual reporting level reports, the report will need to be 
generated twice. Once with the rollup box checked and the 

agency name selected, and once with the rollup box unchecked 
and (All) selected in the reporting level field. 

 

Deleting a Profile 
Select the profile from the Report Name select box. Click the Delete icon from the action bar. 
 
Budget Request Reports 
 
SR05 – Budget Request Summary  
Provides budget information for all expenditures followed by all funding sources.  
  
 

Alternate SR05 Reports 
Click the Series box to generate the Budget Request Summary by Line report, which provides 
expenditures and funding by line. 
 
Click the Agency box to generate the Budget Request Summary by Agency report, which 
provides a summary by major program, line and funding source. 
 
Click the Negative Values checkbox to generate a report showing only negative values, if they 
are present in the columns selected. This is a useful report when entering current biennium first 
year expenditures and current biennium budget amounts.  This report can be used to verify that 
no negative amounts exist in the 2019-21 Biennium Balance column. 
 
The SR05 can also be used to generate reports for subschedules in total or by individual 
subschedule items. Use the subschedule field to select the subschedule. The Project field will 
appear with a dropdown list of each subschedule item or the option to select all projects. 

Examples of the Report Parameters screen and reports are shown on the following page: 
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Salary Reports 

CR01 – Salary Budget 
Provides biennial salary and benefit information by position. Information includes position 
number, name, FTE, new FTE indicator, reporting level percentage, funding source allocation 
percentage, monthly base, proposed biennial salary and benefits, lump sum payments and salary 
adjustments. The report can be generated by individual reporting level, rolled up to an agency 
level or by special line. Additional options can be selected on each of the reports: 
 
 Funded Ind box: 

• ALL – All funded and unfunded positions  
• Funded - All funded positions only  
• Unfunded – Do Not Post - All unfunded positions only  

 Opt FTE box: 
• All Positions - All base budget and optional positions  
• No Optional Positions - Base budget positions only  
• Only Optional Positions  
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Tip   The CR02 – Position Funding reports do not include any lump sum 
payments. The lump sum amounts must be added separately 

to reconcile to the total payroll budget. 
 

 
 
CR02 – Position Funding  
Provides two different reports: Total Position Funding and Fringe Benefit Detail. The report 
choice is selected in the Report dropdown field at the bottom of the window. These reports 
provide additional position information including job class or job class title. Selections can be 
made to sort by position number, class name or employee name, and include salary increase or 
without optional FTE.  
 
The Total Position Funding report provides the salary and benefits as well as the funding source 
amounts. 
 
The Fringe Benefit Detail report allows a selection of four different benefit types, including 
Health, FICA, Retirement, Unemployment, Workers Comp, Medicare, Standard Fringe, Life 
Insurance and Employee Assistance Program.  Any four benefit choices can be selected. When 
the report is generated, remaining benefits are combined into a column titled “Other Benefits.” 
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SR13 – Personal Services Budget 
Provides additional payroll detail for each position in each budget year including class code and 
funding source detail. 
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Subschedule Reports 
 
CR03 – Schedule Information  
Provides reports from posting subschedules. Reports can be generated for the agency, all 
reporting levels, or individual reporting levels.  
 
 Available Posting Subschedule reports: 
 CAP Capital Projects 
 EQP Equipment Over $5,000 
 EXTR Extraordinary Repairs 
 GS Grants Summary 
 ITEQ IT Equip and Software Over $5,000 
 OCP Other Capital payments  
 
The Report Parameters screen choices and the related reports are the same for Equipment, IT 
Equipment, Extraordinary Repairs, and Other Capital Payments. For Capital Projects, the option 
exists to utilize IBARS to report capital projects planned for a six-year period, the budget request 
biennium and the two subsequent bienniums. If you have entered planned projects for the 2023-
25 and 2025-27 beinniums, you can select those bienniums from the dropdown choices to 
generate a report that shows planned capital projects over the six-year period. For Grants, an 
additional dropdown choice exists to display current biennium appropriations for each grant 
description. 
 
CAP – Capital Projects – Subsequent Bienniums 
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CAP – Capital Projects – Budget Request  
(Same Column Choices for Equipment, Extraordinary Repairs, IT Equipment and 
Software, and Other Capital Payments) 
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GS – Grants Summary  

 

 
 
 
 
 



Chapter Ten: Reports           April 14, 2020 
 

10 - 15 

CRSR – Subschedule Reports  
Provides reports from the following non-posting subschedules: 

• General Fund Collections 
• Lease Purchase Agreements 
• Licensing, Regulation and Inspection 

 
An example of the Report Parameters screen and resulting report for General Fund Collections is 
displayed below: 
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SUBSCH1 – Subschedule Info 
Provides a report containing the data entered on the info tabs of the selected subschedules. 
Samples of the reports are included at the end of this chapter. 
 
In order to generate a report select from the dropdown choices for “Subschedule Type” and 
“SubSched No.”  
 
An example of the Report Parameters screen and resulting report for the Continuing 
Appropriations subschedule is shown below: 
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Version Comparison Reports – CR07, CR08, CR09, CR10, and CRCP 
These additional subschedule reports provide a report format similar to the CR03, but allow a 
comparison of two versions. These reports are useful to compare the amounts included in the 
Governor’s Recommendations Version (R02) to the Agency’s Budget Request (B01) for various 
subschedules. 
 

• CR07 – Grants Summary 
• CR08 – Extraordinary Repairs 
• CR09 – Agency Equipment Over $5,000 
• CR10 – Agency IT Equipment Over $5,000 
• CRCP – Capital Projects Agency 
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Miscellaneous Reports 
 
SR01 – Reporting Levels  
The reporting levels report can be sorted by description or reporting level number. The structure 
can be compared to the trees in PeopleSoft, to insure all levels are also included in IBARS.  
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SR04 – Change Package Summary Report  
This report lists all base and optional change packages. It can be generated at the reporting level, 
at the agency level by marking the Code Type Rollup box, and at the line level by marking the 
Series box. In addition, the report can be generated separately for each of the change types A 
through F by selecting the “Chg Grp” dropdown. The reports identify the expenditure account 
codes and funding sources for each change package. In order to validate the budget request, 
expenditures and funding must equal for each change package within each reporting level.  
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CRCS – ND Change Package Summary Report 
This report summarizes all change packages by type and displays the priority level, FTE, and 
funding by sources for each change package. The report can show all changes, only base 
changes, or only optional changes. 
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CR06 – Agency Special Funds Report 
This report provides a two-biennium review of the revenue and expenditure activity of all special 
funds used by the agency. Individual fund numbers or all funds can be selected. 
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SR07 – Version Comparison 
This report allows an agency to compare amounts in selected columns for two different budget 
versions. Individual subschedules can be selected in the Subschedule dropdown or, the Budget 
Request Summary can be selected by leaving that field blank. 
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NARR – Narrative Reports 
Provides reports containing narrative from various budget subschedules. Mark the box next to a 
report type to generate that report. Available report types and a brief description are: 
 

• Agency Overview provides a report containing all agency-wide narrative 
including Statutory Authority and Agency Description. 

• Change Package Narrative provides the narrative included with each change 
package. 

• Program Narrative report provides the narrative entered for each budget 
program. 

• Subschedule report provides the narrative entered for each subschedule. 
• Performance Narrative report provides the agency and program performance 

measure narratives. 
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Submitting the Budget Request 
 
CRVA – Validate Agency Version 
This report is used to identify validation errors that must be corrected before an agency budget 
request will be accepted. Contact the OMB budget analyst after running this report for assistance 
in making the corrections.  
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SR06 – Budget Validation 
This report will identify the reporting level and line ID where errors occur. If a subschedule does 
not check to complete, refer to this report to identify the validation errors. It will provide an 
“Error Message” describing where the problem occurs, such as column, subschedule, account 
code, etc. Contact the assigned budget analyst for assistance correcting errors. 
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Chapter Eleven: Glossary 

Account - A subdivision of a fund. An account is a classification by which information on 
particular financial transactions and financial resources is recorded and arranged. 

Addition - Extension, enlargement, or expansion made to an existing asset. 

Agency Budget Number - The three-digit number assigned to each Business Unit by OMB. 

Agency or Business Unit - A principal, functional, and administrative entity created by statute 
within state government. 

Allotment - A procedure under which appropriated funds are restricted when resources are 
insufficient to cover appropriations based on the most recent revenue forecast. Allotment, 
authorized by NDCC 54-44.1-12, is intended to assure that expenditures do not exceed available 
resources during a biennium. 

Appropriation - A legislative authorization to expend resources. An appropriation specifies the 
amount of money to be used for a particular purpose during a period of time, usually one 
biennium. 

Appropriation Authority – Authorization in an Appropriation Act for an agency to expend 
funds. 

Appropriation Bill - A bill through which appropriations are given legal effect. 

Balanced Budget - A budget in which estimated expenditures for the fiscal year are equal to or 
less than projected revenues for the same period. In certain situations, a balanced budget may 
include the beginning balance in projected revenues. 

IBARS - Internet Budget Analysis and Reporting System. 

Base Budget Request - The statement with accompanying explanations in which a state agency 
sets forth its financial requirements and plans for a biennium within constraints set by the 
Governor. 

Biennium - The period of two state fiscal years for which the budget is written. For example, the 
2021-23 budget covers the period July 1, 2021 to June 30, 2023. 

Budget - The complete financial plan for the state for the fiscal period, as proposed in the 
executive recommendation and modified and adopted by the Legislature in appropriation and 
revenue acts. 

Budget Account Code - A six digit code used for accounting and budgeting purposes, in lieu of 
a written description, to describe the specific items anticipated to be purchased in the budget, or 
purchased within various expenditure categories. Codes are assigned by OMB. A budget account 
code is a rollup of detail account codes. 

Budget Document - The instrument used by OMB and the Governor to present a comprehensive 
financial program to the Legislature. The budget document consists of three parts. The first 
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contains a summary of proposed expenditures and the means of financing them. The second 
consists of schedules supporting the summary.  The third part is the necessary legislation to put 
the budget into effect including appropriation, revenue, and borrowing measures. 

Budget Level - Consists of one or more department levels rolled up to a major program or 
subprogram.  

Budget Message - A general discussion of the proposed budget as presented in writing by the 
Governor to the Legislature. The budget message contains an explanation of the principal budget 
items, an outline of the government's experience during the past period, its financial status at the 
time of the message and recommendations regarding the financial policy for the coming 
biennium. 

Budget Request - The statement with accompanying explanations that a state agency uses to set 
forth its financial requirements and plans for a biennium. 

Budget Request Checklist – The IBARS tab listing all subschedules to be completed before the 
budget request can be submitted. 

Budget Request Summary – The IBARS subschedule that summarizes the budget request by 
reporting level. 

Budget Stabilization Fund (Rainy Day Fund) - A special fund with reserve dollars to be used 
only in time of great need. 

Budget Version – A variation of a budget request separately identified in IBARS. A different 
budget version exists at various stages of the budget process. These include download versions 
that are the starting point of the budget process, agency work-in-progress versions, the budget 
request, OMB analyst work-in-progress versions, and the Governor’s recommendations. 

Capital Assets – Expenditures for capital projects, extraordinary repairs and equipment over 
$5,000.  In IBARS, capital assets are the subschedules that summarize the budget request for 
capital projects, extraordinary repairs, equipment over $5,000, IT equipment and software over 
$5,000, and other capital payments. 

Capital Budget - The portion of the budget devoted to proposed additions and repair of 
buildings and land and the means of financing those assets. The capital budget portion of the 
budget includes money for building new state facilities and making improvements to existing 
facilities. 

Capital Projects - Expenditures for new construction, additions, restorations, and demolitions of 
buildings and infrastructure. 

Capital Carryover - The unexpended balance of an appropriation, remaining at the end of the 
biennium, approved for expenditure by the carryover committee. 

Comprehensive Annual Financial Report (CAFR) - The official annual report of a 
government, prepared in conformity with GAAP and organized into a financial reporting 
pyramid. 
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Continuing Appropriation - Statutory authorization for an agency to accept revenue and make 
expenditures that are not subject to the biennial appropriation process. In IBARS, the 
subschedule that provides the statutory authority and the estimated revenues and expenditures for 
each continuing appropriation fund. 

Debt Limitation - Constitutionally or statutorily imposed limits on state obligations. 

Debt Service - A category of appropriations and expenditures used for the payment of principal 
and interest on debt. 

Dedicated Fund - A fund that receives and expends revenue collected by the state for a specific 
purpose. 

Dedicated Tax - A tax levied to support a specific government program or purpose. 

Deficiency Appropriation - An appropriation used to meet obligations not foreseen when the 
biennial budget was enacted and for which the costs would exceed available spending 
authorizations. It might add to a previously authorized appropriation anticipated to be 
inadequate, or provide a new appropriation to finance an existing or anticipated liability for 
which no appropriation exists. 

Deficit - The amount by which spending exceeds income within a given fiscal period. 

Demolition - All expenditures associated with tearing down an existing building or structure.  

Department ID - Provides a means for entering and tracking accounting data. It is the lowest 
level of detail for accumulating costs. 

Direct Costs - Costs specifically traceable to certain goods, services, units, programs, activities, 
or functions. Direct costs differ from indirect costs in that the latter cannot be specifically traced 
and so must be allocated on some systematic and rational basis. 

Enterprise Resource Planning (ERP) – An administrative software system that covers the 
entire enterprise. 

Executive Recommendation - The Governor's constitutionally mandated plan of appropriations, 
expenditures, and cash disbursements, along with estimates of revenues and cash receipts 
expected to be available to support those expenditures. 

Expenditure - Decreases in net financial resources. Expenditures include current operating 
expenses requiring the present or future use of net current assets, debt service and capital outlays, 
and intergovernmental grants, entitlements and shared revenues. An expenditure occurs when the 
liability is incurred for goods and services received regardless of when the money is disbursed.   

Extraordinary Repair - Relatively large expenditures for repairs that benefit more than one 
operating cycle or period.  Extraordinary repairs are non-recurring in nature and increase the 
value or service life of the asset.  

Federal Funds - Funds received or requested directly from the federal government, or federal 
funds passed through from another state entity. 
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Fiscal Note - The statement of fiscal impact (revenue and/or expenditure) that a proposed bill 
will have on the state, its political subdivisions, or the citizens of the state. 

Fiscal Year - The state fiscal year runs from July 1 through June 30. The federal fiscal year runs 
from October 1 through September 30. The fiscal year for counties and cities is the calendar 
year. 

Fringe Benefits - Payments made by the state for retirement, social security, health insurance, 
workers compensation, and unemployment insurance. 

Full-time Equivalent (FTE) Position - A full-time position approved by the Legislature. A full-
time work year is 40 hours per week, 52 weeks per year. 

Fund - A fiscal entity segregating the financial resources of the state.  Monies in a fund may be 
used for a specific purpose as provided by law. Each fund is a self-balancing set of accounts 
recording resources, obligations, reserves, and equities in accordance with GAAP. 

Fund Number - A three-digit code assigned by OMB to each fund for accounting purposes. 

Funding - The source of operating revenue for a department. The three categories for funding 
are general, federal, and special. 

Funding Reallocation – The IBARS feature allowing an agency to allocate the funding source 
percentages for an entire version, reporting level, or line item. 

General Fund - The major operating fund of the state that receives all state income not 
earmarked for a particular program or activity and not specified by law to be deposited into 
another fund. 

Generally Accepted Accounting Principles (GAAP) - Uniform minimum standards and 
guidelines for financial accounting and reporting. 

Goal - A long-term (multi-year) vision of the future; the general end towards which efforts are 
directed. 

Governmental Accounting Standards Board (GASB) - An independent, professional body 
that establishes standards for accounting and financial reporting applicable to state and local 
governmental entities. 

Improvement (or betterment) - The removal of a major part or component of an asset and the 
substitution of a different part or component having significantly improved and superior 
performance capabilities. 

Indirect Costs - The elements of cost necessary in the production of goods or services that are 
not directly traceable to the product or service.  

Internal Controls - Methods and measures adopted within an organization to safeguard its 
assets, check the accuracy and reliability of its accounting data, promote operational efficiency, 
and encourage adherence to prescribed managerial policies. Internal controls encompass both 
internal administrative controls and internal accounting controls. 
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Large IT Project - Information Technology (IT) projects with a budget in excess of $500,000. 
In IBARS, these projects are reported through the Large IT Projects subschedule. 

Line Item (Class [PS]) - A line item is a subdivision of an appropriation such as salaries and 
wages, operating expenses, and capital assets. 

Matching Funds - A type of grant requiring the government or agency receiving the grant to 
commit a certain amount of funding to the program before funds will be made available by the 
granting entity. 

Mission - A broad statement of the overall purpose of an agency's existence including what they 
do, why they do it, and for whom they do it. 

Navigation Path - The menu options a user must select to access a particular window. 

Non-appropriated - Revenues or expenditures of governmental entities that are not subject to 
the appropriation process. 

Non-recurring Revenues - Revenues available during a fiscal period that will not be available 
in subsequent fiscal periods. 

Operating Budget - Plans of current expenditures and the proposed means of financing them.  
For the State of North Dakota, this is the proposed plan of funds necessary to run a program, 
excluding the cost of capital construction. 

Operating Maintenance - Expenditures for maintenance and ordinary repairs to keep assets in 
usable condition. Operating maintenance is either recurring or incurred on a continuous basis, 
not capitalized, and involves dollar amounts less than $1,500. Examples include paint, floor wax, 
lubrication, cleaning supplies, and air filters.  

Optional Request - The statement with accompanying explanations in which a state agency sets 
forth its financial requirements that exceed the base budget constraints set by the Governor. 

Other Funds - Non-general fund amounts appropriated by the Legislature, which include all 
federal and special funds. 

Pay Plan - The schedule of employees' salaries and benefits used in developing the salaries and 
wages line item. 

Peoplesoft Financials - Name of the computerized system used in North Dakota state 
government to account for all financial transactions. 

Peoplesoft HR/Payroll - Name of the computerized system used in North Dakota state 
government to account for all human resource and payroll transactions. 

Preparation Level - The detail level at which the budget request is entered. 

Performance Measure - The gauge used to measure progress towards a stated goal. 

Position Detail Data – The IBARS subschedule used to enter all payroll information for the 
budget request biennium. 
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Program - A functional unit of activity representing the basic budget unit used to describe and 
account for services provided by state government. Programs have an identifiable objective that 
can be evaluated for performance. 

Program Objective – The ultimate purpose of a program, towards which efforts are directed, 
stated in terms of a measurable result. 

Receipts - A general term for cash received which may either satisfy a receivable, or be a 
conversion of another asset or a refund of a prior expenditure. 

Receivable - An anticipated sum of money treated as revenue even though it is not in hand.  
Such sums are available for expenditure by state agencies when properly authorized. The 
establishment of a receivable amount results in an increase in an asset balance. 

Renovation - Substantial changes to an asset bringing it to a condition better than it was when 
originally built.  

Replacement - Involves the removal of a major part or component of an asset and the 
substitution of a new part or component of essentially the same type and performance 
capabilities. 

Reporting Level - A 16-digit number grouped into seven different "layers" by hyphens used to 
identify the agency, major program level, and cost center in IBARS. By using the seven different 
layers, reports can be generated at any level from accounting cost center to statewide 
summarization.   

Restoration - An expenditure to bring an asset back to its original condition or state. 

Revenue Estimates - Projections of anticipated state revenue for the current and future biennia. 

Revolving Fund (Account) - A fund (or an account within any fund) established to finance (1) 
state activities of a business or commercial nature or (2) the operation of an intra governmental 
service agency or enterprise, which generates receipts (income) from the sale of commodities or 
services.  Such receipts are available for the continuing operation of the activity or enterprise. 

Security Level - A code used by the IBARS system to control data access.   

Special Funds - Monies derived from sources such as local governmental units, special funds, 
departmental collections, and private contributors. 

Special Fund Balance – The IBARS subschedule used to prepare special fund statements for the 
current and budget request bienniums for special funds used by the agency.  

Strategic Plan - An action-oriented guide developed through an examination of internal and 
external factors that directs goal-setting and resource allocation to achieve meaningful results 
over time. 

Subschedule Copy – The IBARS feature that allows the user to copy data from one budget 
version to another.  This feature may be used to copy previous biennium data, such as narrative, 
into a working version. 
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Success Indicator - The gauge used to measure progress towards a stated goal. 

Surplus - The amount income exceeds spending within a given fiscal period. 

Transfers - The movement of cash or other resources between funds, as legally authorized.  

Trust Funds - Funds used to account for assets held by a government in a trustee capacity for 
individuals, private organizations, other governments, or other funds. 

Unexpended Appropriated Balance - The appropriated authority minus actual expenditures.  
The same amount as the portion of an appropriation not yet expended.   

User Taxes and Fees - Charges associated with using a particular service or facility (e.g., park 
entrance fees, highway tolls). 

Versions Tab – The IBARS window used to select, create, or delete versions of a budget. 

Veto - The constitutional authority of the Governor to disapprove bills passed by the Legislature.  
The line item veto is the authority of the Governor to disapprove any item or items of 
appropriation while approving the rest of the appropriation bill. The Legislature may override a 
veto or line item veto with a vote of at least two-thirds of the members of each House. 
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